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About this manual 

Intended audience 
Users who need to configure 3000 Series PXI modules to create logical instruments for signal 
generation and analysis. 

Structure 
Chapter 1 Common plugin control 

Chapter 2 System configuration 

Chapter 3 Signal generator front panel 

Chapter 4 Digitizer front panel 

Chapter 5 Combiner 

Chapter 6 Spectrum analysis 
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Associated documentation 
If you want to… Refer to… 

Find information about soft front panels, 
drivers, application software, data 

sheets, getting started and user manuals 
for this and other modules in the 

3000 Series. 

PXI Modules CD-ROM 

Part no. 46886/028 

Supplied with the module 

Install modules into a rack, interconnect 
them, power up and install drivers. 

3000 Series PXI Modules Common Installation Guide 

Part no. 46882/663 

On the CD-ROM and at www.aeroflex.com 

Set up a populated chassis ready for 
use. 

3000 Series PXI Modules Installation Guide for Chassis 

Part no. 46882/667 

On the CD-ROM and at www.aeroflex.com 

Set up and use the signal generator 
application for 3010 Series and 

3020 Series modules. 

Getting Started with afSigGen 

Part no: 46892/678 

On the CD-ROM and at www.aeroflex.com 

Set up and use the digitizer application 
for 3010 Series and 3020 Series 

modules. 

Getting Started with afDigitizer 

Part no: 46892/676 

On the CD-ROM and at www.aeroflex.com 
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System requirements 
Intel-based PC with 1.5 GHz Pentium processor or equivalent 

Microsoft Windows NT 4.0, 2000 / XP / Vista (32 bit) 

512 MB RAM Minimum (Windows NT 4.0, 2000 / XP) -1024 MB RAM recommended 

1024 MB RAM Minimum (Windows Vista) 

Aeroflex PXI hardware drivers version 5.4.0 or later 

Screen and graphics card capable of displaying 1024 x 768 pixels 
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PXI Studio overview 

Introduction 
PXI Studio is an application that is designed to bring all Aeroflex PXI measurement and 
control functionality under the control of one easy-to-use application. 

Plugins 
PXI Studio uses a number of different application plugins, which provide functionality for 
controlling hardware settings, making measurements, or configuring your hardware system. 

By default, PXI Studio is supplied with five plugins: 

System Configuration 
This helps you to set up your PXI hardware. 

Signal Generator front panel 
This allows you to directly manipulate and control a PXI 3020 Series module, together with a 
3010 Series module if required. 

Digitizer front panel 
This allows you to directly manipulate and control a PXI 3030 Series module, together with a 
3010 Series module if required. 

Combiner plugin 
This allows you to set up and control a PXI 3060 Series RF combiner. 
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Spectrum analysis plugin 
This allows you to perform spectral measurements using a Digitizer Instrument consisting of 
PXI 3030 Series and 3010 Series modules. 

This document contains information about how to launch these plugins.  Other optional 
plugins are available - for information about how to launch and use other plugins, please refer 
to the documentation supplied with the plugin. 

File menu 

Saving a plugin’s settings 
All measurement and instrument control plugin windows provide the ability to save their 
settings to a file for re-use at a later date.  To save the current active plugin’s settings to a file, 
click the File->Save As top-level menu.  This asks you to specify the filename you wish to 
save.  Once you have selected a file, click the Save As button and the file is saved.  
Alternatively, to cancel the save, click Cancel.  By default, all plugin save files are stored in a 
.PXS format. 

Alternatively, if you have already saved the plugins settings to a file, click the File->Save 
button on the top-level menu and this stores the plugin’s settings to the previously saved file. 

Opening plugin settings 
If you have previously stored a plugin’s settings, you can open the file by clicking File->Open 
on the top level menu.  Once you have selected the file you wish to open, click Open. 

If the file is a valid PXI Studio settings file (.PXS), the plugin is recalled with the settings 
stored in the file.  Note that in the cases of plugins that make use of PXI hardware, opening a 
settings file automatically attempts to boot and load the hardware. 
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Closing the application 
To close the application, you can either click the close window icon at the top right-hand side 
of the application window, or click File->Exit. 

Window menu 
PXI Studio uses a MDI interface, which means you can have multiple windows open together.  
To allow easy manipulation of these, PXI Studio provides a windows menu: 

Close 
Closes the currently active plugin. 

Close all 
Closes all open plugins. 

Cascade 
Stacks all open plugins on top of each other in a standard windows cascade. 

Arrange Icon 
Aligns all minimized windows. 

Next 
This moves to the next active plugin. 

Previous 
This moves to the previous active plugin. 

Tools Menu 
The tools menu provides the ability to view and modify the configuration of PXI Studio 
plugins. 
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Registered plugins 
To view, add or remove plugins from your system, click Tools -> Registered Plugins to view 
the registered plugins screen: 

 
This screen shows you an overview of the registered plugins in your system, as well as their 
version number. 

Removing a plugin 
To remove a plugin, first select the plugin you wish to remove, then click Remove. 

Adding plugins 
To add a plugin, or plugins, click the Add button and select the plugin library that you wish to 
register. 

Note that if you do not have sufficient administration privilege on the machine to write to the 
HKEY_LOCAL_MACHINE registry key, you are not able to add or remove plugins. 
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Colors of controls 
References to colors in this document assume that your desktop is set to display the Classic 
Windows color theme.  If you have set a different desktop color theme, colors may vary in 
descriptions throughout this document. 
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Chapter 1   
Common plugin control 

Overview 
Most Plugin screens consist of a number of different panels that allow you to modify settings 
and display information.  Each of these panels can be independently moved, rearranged and 
stacked in order to create a customized layout for each Plugin. 

By default; each Plugin contains a pre-defined layout that is automatically loaded whenever a 
default Plugin screen is activated. 

This section describes how to manipulate these panels in order to customize your Plugin 
layout. 

While this document uses the Digitizer Front Panel Plugin as an example, the methods of 
customizing your layout are the same for all Plugins. 

Creating a new panel 
Once you have opened the Plugin you wish to use, right-click on one of the existing panels’ 
title bars to activate the Plugin menu.  This displays a list of new panels that can be created.  
To create the panel, simply click on the menu item of the panel you wish to create.  
Documentation about the what panels can be created, and how to control them, can be found 
within the documentation for the Plugin you are using. 
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Note that some panels can only be created once, meaning that only one can be displayed at a 
time.  If the panel you want to create does not exist, check to make sure that the panel is not 
already on your layout. 

Once you have clicked on an item, a new floating panel is created: 

 
By default, all panels are created as top-level floating windows. 

Closing a panel 
If there is a window that you wish to remove from the main Plugin screen, click on the panel’s 
title bar, and select the close button: 

 
This removes the panel from the main Plugin screen. 
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Popping out a panel 
All panels can either be part of the main Plugin screen, or can exist as separate top-level 
floating windows. 

To change a panel that is part of the main Plugin screen into a floating screen, click on the 
‘restore’ button on the title bar of the panel you wish to pop out. 

 
Clicking this button moves the panel out into a floating window. 
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Restoring a panel 
If you want to restore a window to its original location, click again on the restore button at the 
top of the window’s title bar; this pops the floating window back into the main Plugin screen. 
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Docking a panel 
Alternatively, if you want to place a floating window in a new position within the main Plugin 
screen, you are able to dock this window into any available location within the main Plugin 
screen, provided that there is enough space available to do so. 

To dock a floating window, simply drag the window to the edge of an existing panel using the 
left mouse button.  If there is enough room available, the other panels in the main Plugin 
window resize to indicate that you can place this window at this location. 
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Then simply release the left mouse button to drop the window into that location. 
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Stacking panels 
As well as being able to drop in, you also have the ability to stack panels with other existing 
panels in the main Plugin screen.  To do this, instead of moving the floating window to the 
edge of an existing panel, move it to the center.  If there is enough space, the panel you are 
stacking now shows a tab at the bottom of its window, indicating that the window you are 
dragging can be stacked. 
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Then, as before, release the mouse button to drop this window into the selected panel: 

 
Each Plugin supplies a number of different panels that allow you to modify settings and 
display information 
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Resizing a panel 
Each panel that has been created can also be resized.  To do this, click on the boundary bars 
between panels and drag them in order to achieve the required size. 

Using this drop-in and out mechanism, it is possible to create complex Plugin windows that 
can display a large amount of graphical information: 

 

Note: if there is not enough room on the screen for a new panel to be inserted into the main window, 
then you are not able to drop a new panel into it.  Each window has a minimum size requirement, 
which means that large windows, such as the IQ Capture Display panel, cannot be dropped into small 
locations.  In order to drop in extra windows, it may be necessary to resize your main Plugin window 
in order to make enough room for them to fit. 
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Graph output display 

 
Some Plugins allow you to display the resulting measurement information in a graphical 
format.  This section describes the common functionality of the graphical output window.  
While this document uses the Digitizer Front Panel Plugin as an example, the methods of 
controlling and manipulating your graphical output is the same for all Plugins. 

The graph has two modes of operation: 

Zoom mode 
This mode allows you to perform a rubber-band style selection on the graticule. 
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Selection mode 
This allows you to manipulate markers, and perform bar selections of the graph. 

Graph output display control bar 

 
This part of the graphical output display allows you to change the information you are 
displaying. 

Changing the graph type 
Most Plugins provide the ability to display more than one measurement type.  To change the 
measurement type displayed, click on the name of the current graph at the top left of the 
graphical display, and a menu of available measurement types is displayed.  To change to a 
new measurement, simply select the desired measurement, and the graph updates 
automatically. 
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Zooming in 
To zoom in on the information displayed on the Graph display panel, click on the zoom menu 
at the top of the panel and select the Zoom In option to zoom in by a factor of 2. 
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To select a region to zoom, click on the Zoom menu at the top of the panel and select the 
Zoom Selection option.  Notice that the graph now displays the co-ordinates of the mouse 
cursor.  To zoom in on a region of the display graph, click and hold the left mouse button and 
drag it to select the region of the graph you want to zoom into. 

 
Once the zoom has been completed, the Graph display reverts to its default selection mode. 

Zooming out 
To zoom out, click on the zoom menu at the top of the panel and select the Zoom Out option.  
This causes the Graph display to zoom out on the x-axis by a factor of 2, maintaining the 
current central point.  If the Graph display cannot achieve this zoom factor, as doing so 
exceeds the graph’s maximum scale limits, the maximum possible scale is set instead. 
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Changing the graph scale 
To change the X and Y axis scales for a given graph, click on the zoom menu at the top of the 
panel and select the Change Scale option.  This displays the scaling screen: 

 
The way you specify the scale of the X and Y axis depends on the type of data that the active 
graph is displaying.  The different methods are as follows: 

Centre, Span 
This allows you to specify a scale in terms of a center point and a span. 

Reference, Scale/Division 
This allows you to specify a scale in terms of a reference, which is the maximum value of the 
display, and value for each division of the graph. 
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Minimum/Maximum 
This allows you to specify a scale in terms of a start and stop limit. 

Changing the scale 
Whenever you modify the scale using this screen, the new scale limits are automatically 
applied to the graph display, allowing you to see the new scale immediately.  However, these 
changes are only permanently applied when you click Ok.  If you click Cancel at any time, 
the Graph display scales are reset to their original values. 

Axis limits 
There are normally limits on the scales you are allowed to enter on this screen.  These are 
generally dependent on the measurement that is being made. 



COMMON PLUGIN CONTROL 

16 

Graph Display menu 
As well as the standard control buttons that comprise the control bar, the Graph Display panel 
provides extra capabilities for adjusting and analyzing your measurement data. 

Many of these can be accessed by right-clicking on the graph graticule to display the graph 
popup-menu: 

 
By default, this menu provides the following functions: 
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Zoom sub menu 
This sub menu the ability to modify the X axis zoom factor. 

Zoom In (x 2) 
This increases the zoom of the current graph’s X axis by a factor of 2, retaining the current 
center point. 

Zoom Out (x 2) 
This decreases the zoom of the current graph’s X axis by a factor of 2, retaining the current 
center point.  If the IQ Capture Display graph cannot achieve this zoom factor, as doing so 
exceeds the maximum limits for samples or frequency, the maximum possible scale is set 
instead. 

Reset Zoom 
This resets the zoom factor of the current graph’s X and Y axes to their default values. 

Trace Controls sub-menu 
Trace enable/disable 
This gives you the ability to turn on and off different traces within the graph independently.  
This option is only available if there is more than one independent trace running for the given 
graph, for instance I and Q traces. 
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Markers sub-menu 
The Markers sub-menu allows you to control how markers are displayed on the graph.  You 
have the ability of enabling up to four markers and a delta marker.  For more information 
about markers, see the markers section of this document. 

All Markers Off 
This function allows you to turn off all markers that are currently enabled. 

Enabled 
This function allows you to turn a marker on or off.   The first time a marker is enabled; it is 
automatically moved to the location you initially right-clicked. 

Move to here 
This function allows you to move the specified marker to the location at which you initially 
right-clicked. 
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Graph display selection mode 
Selection mode allows you to manipulate graph information using the mouse pointer.  Using 
the mouse, it is possible to select a full region of X axis data, as well as moving markers to 
different locations. 

Selecting a region of data 
The data selection mechanism in the Graph display allows powerful control of the data that is 
being displayed. 

To make a selection, click and hold the left mouse button at the start of the section you want 
to select, then drag the mouse to the end of this section: 
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Zooming to the selection you have made 
To zoom in on the selection you have made, right-click the mouse button over the selection 
and select ‘Zoom to this selection’ from the resulting popup menu. 

Applying the selection to another graph 
If more than one graph is being displayed, it is possible to use the selection mechanism to set 
the data that other graphs are displaying.  Take the following Digitizer Plugin screen as an 
example: 

 
In this situation, you may want to analyze the spectrum of the selected region in the top Graph 
display panel. 

To do this, click and hold the left mouse button over the selection you want to apply to the 
spectrum measurement, and drag the mouse over to the IQ FFT window: 
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When a selection is being dragged, you see the mouse cursor change into a small picture of 
the selection you have made.  Then, to apply this selection to the second graph, simply release 
the left mouse button and drop the new selection in: 

 
In this example, after you release the selection, the Spectrum graph window displays the FFT 
of the selection you dropped in. 

You can select and drag any selection onto another graph that can work in terms of the data 
domain of the original selection.  This means that you can drag a selection from any graph that 
is displayed in terms of samples onto any graph that can process a selection of samples.  It is 
not possible to drag a selection from a graph that is displayed in frequency onto a graph that is 
displayed in terms of time. 
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Markers 
The graph display panel allows you to display up to four markers and a delta marker.  The 
information of each marker, such as X and Y values and delta values are displayed in the 
marker table, which is located beneath the main graticule when more than one marker is 
enabled. 

Enabling a marker 
To enable a marker, click on the location where you wish to place the marker, and use the 
Graph display menu to enable the marker.  This displays the marker on the screen; if there 
were previously no markers displayed, the marker display table is displayed: 
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Removing a marker 
To remove a marker, right-click on the graph graticule to display the Graph display menu, 
select the marker you wish to remove and click Enabled. 

Moving a marker 
To move a marker to a new location, hover your mouse over the marker until the cross-hair 
changes to the resize cursor, then simply hold the left mouse button and drag the marker to the 
desired location, and release the mouse. 
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Delta marker 
The delta marker is manipulated in exactly the same way as normal markers.  However, you 
can only display a delta marker if a normal marker is enabled. 

When a delta marker is enabled, the marker table is updated with delta values: 
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Text results panel 
Some Plugins allow you to display measurement results in a text format using a standard text 
results panel.  For details on what text measurements a Plugin can display, consult the relevant 
documentation for that Plugin. 

 



COMMON PLUGIN CONTROL 

26 

Showing a measurement 
To show the text for measurement, select the item in the menu.  This causes the text display to 
start displaying the measurement. 
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You can also use the right mouse button to display the menu. 
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Chapter 2   
System configuration 

Overview 
The System Configuration Screen allows you to define and manage how your PXI modules 
are used within PXI Studio. 

Referencing multiple PXI modules by their VISA resource ID can be difficult and non-
intuitive, so the System Configuration Screen allows you to group PXI modules together to 
form unique ‘logical instruments’ that can then be used by PXI Studio plugins. 

The unique name given to the instrument, rather than the VISA resource ID, is then used when 
requesting PXI hardware.  This makes it simple to select what hardware you want to use 
within PXI Studio plugins. 
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The logical instruments that can be created are as follows: 

Signal generator: 

 Requires one 3010 Series and one 3020 Series PXI module. 

Digitizer: 

 Requires one 3010 Series and one 3030 Series PXI module. 

Combiner: 

 Requires one 3060 Series PXI module 

Note that if a PXI module has been assigned to a logical instrument, it cannot be assigned to 
another. 
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Hardware Profile 
PXI Studio allows you to store a number of different hardware profiles, and select the active 
profile to use.  Any changes that you make to the system configuration are applied to the 
active profile, and do not affect any other profile that has been saved. 

If you press the Edit Profile button, the following form is displayed, allowing you to add, 
remove or select a profile. 

 

PXI System 
This part of the System Configuration screen gives a brief overview of the devices that have 
been found in the system, as well as providing the ability to automatically configure your 
entire system. 
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View Details 
To view the details of any PXI modules that have been found in your system, click the 
View Details button; this displays the PXI Device Summary screen. 

 

Generate Frequency Standard Settings 
This check box allows you to specify whether frequency standard connection information is 
automatically generated when you perform an automatic configuration. 
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Auto Configure 
The Auto Configure System button automatically creates as many logical instruments as can 
be created from discovered PXI devices in your system.  If a logical instrument requires more 
than one device (for example, a signal generator device requires a 3010 Series module and a 
3020 Series module), it tries to use devices that are closest together in the PXI rack. 



SYSTEM CONFIGURATION 

33 

Logical Instruments 
This part of the System Configuration Screen lets you view and modify the logical 
instruments that have been defined. 

Creating an instrument 
To create an instrument, click on the Create Instrument button.  This displays the 
Instrument configuration wizard. 

Removing an instrument 
To remove an instrument that has been defined; first select the instrument you wish to remove 
from the Logical Instruments list, and click the Remove button.  Alternatively, you can right-
click on the instrument you wish to remove and select Remove from the popup menu. 

Clearing all instruments 
To remove ALL defined instruments, click the Clear button. 

Configuring the frequency standard 
To manage how your PXI devices and instruments use their frequency standard, click on the 
Frequency Standard button to display the Frequency standard configuration manager. 
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Instrument configuration wizard 
The instrument Configuration Wizard allows you to create a logical instrument in a series of 
simple steps.  Each step gives basic information about what you need to define in order to 
create your instrument. 

When first entering the wizard, you are asked to define basic information about the instrument 
you want to create: 

 

Instrument type 
This is the type of logical instrument you want to create, which can be one of the following: 

Signal Generator (requires an available 3020 Series module and 3010 Series module) 

Digitizer (requires an available 3030 Series and 3010 Series module) 

Combiner (requires an available 3060 Series module) 



SYSTEM CONFIGURATION 

35 

If you do not have the required PXI devices in order to create a particular type of logical 
instrument, then that instrument type is removed from the list. 

Instrument name 
This is a descriptive name that is given to the instrument.  Whenever you want to control PXI 
hardware through PXI Studio, this descriptive name is used to differentiate between 
instruments. 

If you are happy with the instrument type and the name you want it to have, click Next.  To 
close the instrument configuration wizard without applying your changes, click Cancel. 

After setting up basic information about your instrument, you are asked to specify the 
individual PXI devices that this instrument uses: 
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This section allows you to specify the PXI devices that this instrument uses.  The type of PXI 
device that this instrument requires is displayed at the top of the screen; a list of available 
devices is presented below.  Simply select the PXI device you want this instrument to use, 
then click Next.  Once all PXI devices that this instrument type requires have been selected, 
click Finish. 

If you wish to cancel all your modifications, click Cancel. 

Once your settings have been applied, the newly-created instrument appears in the 
Logical Instruments list in the main Hardware Configuration screen. 
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Frequency configuration manager 
The System Configuration screen allows you to define how all devices use their frequency 
standard.  This definition is then used to automatically configure your instruments’ frequency 
standard whenever they are in use. 

To bring up the Frequency Configuration Manager, click on the Frequency Standard button 
in the main System Configuration screen. 

 
This manager allows you to define how many different frequency standards are present in 
your system, as well as what devices are using it. 
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This manager gives basic information about how each device is configured.  This example is 
of a configured FSTD summary screen: 

 

Device Type 
This specifies what type of PXI module this device is. 

Frequency Standard 
This specifies how the module’s frequency standard is configured. 

Instrument 
This specifies the logical instrument that this module is a part of, if applicable. 

Resource String 
This is the VISA resource of the specified module. 
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To create a new frequency standard, click on Add Group.  This adds a new Frequency 
Standard group to the list. 

 
To remove this group, click on the Remove Group button. 

To configure or edit what devices use this frequency standard, and what device supplies the 
frequency standard source, select the group and click the Configuration Wizard button. 
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Frequency standard configuration wizard 
The first screen of the Frequency Standard Configuration wizard allows you to select what 
instruments are connected to this frequency standard, and the booting policy. 

 
The Connected Devices section lists the devices that will use the frequency standard, the 
Available Devices section lists the devices that have not yet been assigned to a frequency 
standard. 

You can move devices to and from these lists by clicking on the << and >> buttons.  To move 
all the devices, click Clear All Devices or Add All Devices. 

Boot policy 
As a frequency standard may have several different devices in different frequency standard 
states, especially if you are using these devices externally to PXI Studio, it is necessary to 
specify how the frequency standard is set up if it is in use. 
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Boot all Instruments when this Frequency Standard Group is in use 
If this policy is selected, whenever you try and use a device connected to this frequency 
standard, all devices that are configured as using this frequency standard are booted and have 
their frequency standard initialized.  While this ensures that there is no frequency standard 
contention, as all devices are explicitly configured, it can mean extended boot times in racks 
with a large number of devices. 

Boot only required instruments that are in use 
If this policy is selected, whenever you try and use a device connected to this frequency 
standard only this device, and any device that provides the frequency standard source, is 
booted.  All other devices using the frequency standard are not modified.  While this means 
that as few instruments are booted as possible, it means there is a potential for frequency 
standard contention if one of the unused devices is currently configured as a frequency 
standard output. 

Once you have selected the boot policy, and the devices that use the frequency standard, you 
can either click on Next to continue to the source selection page if your frequency standard 
group contains more than one 301x or if your frequency standard group contains no 301x 
devices, you can click Finish to apply your changes.  If you want to cancel your changes, click 
Cancel. 
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The next screen of the Frequency Standard Configuration wizard is the source selection 
screen.  This allows you to specify where the frequency standard comes from. 

 
The Frequency Standard is supplied by a device outside this group 
Selecting this option means the frequency standard source is supplied by a device outside the 
control of PXI Studio.  Selecting this option means that you must manually configure your 
frequency standard source. 

The Frequency Standard is supplied by a device in this group 
Selecting this option means that one of the instruments in this frequency standard provides the 
frequency standard source. 
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Selecting the frequency standard source 
If you have specified that a device in this group supplies the frequency standard source, you 
must specify the device that provides it.  To do this, simply click on one of the available 
devices in the list. 

 
Once you have selected your frequency standard source and you there are more than one 
301x’s that have not been configured as a frequency standard source, click Next to select how 
this frequency standard is terminated.  Otherwise, you can click Finish to apply your settings.  
If you wish to cancel the changes you have made, select Cancel. 

If you have more than one 301x in your group that has not been specified as a frequency 
standard source, the next screen in the frequency standard wizard is displayed.  This screen 
allows you to specify the device that provides the 50 ohm termination for your frequency 
standard group. 
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Termination 
This control allows you to specify whether the frequency standard group is terminated or not.  
If this is cleared, no device in this group provides termination for the frequency standard.  If 
this control is checked, you must specify the device that is to provide the termination. 

Selecting the frequency standard termination 
If you have specified that a device in this group provides the termination for your frequency 
standard, you must specify the device that provides it.  To do this, simply click on one of the 
available devices in the list. 
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Chapter 3   
Signal generator front panel 

Overview 
The Signal Generator Front Panel plugin allows you to set up and control a Signal Generator 
Instrument (3020 Series and 3010 Series PXI modules). 

To open the Signal Generator front panel, click Instrument Control on the top-level 
PXI Studio menu, and select Signal Generator Front Panel. 

If this entry does not appear on the top level menu, select Tools -> Registered Plugins and add 
the plugin afSigGenPlugin.dll. 

When opening the Signal Generator front panel, if there is only one signal generator 
instrument available in your system, it is automatically selected and booted.  Otherwise, you 
are asked to select which instrument you wish to control: 
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This screen provides a list of ‘logical instruments’ that you have defined in your System 
Configuration, which match the type you have requested.  Note that instruments that are 
currently in use by other plugins do not appear in this list. 

Click on the name of the instrument you wish to use, and click Ok.  Alternatively, if you do 
not wish to proceed to the Signal Generator front panel, or the hardware you wish to control is 
not present in the list, click Cancel. 

Once you click Ok, the instrument and other instruments that comprise your frequency 
standard (depending on the frequency standard configuration defined in System 
Configuration) are booted if required.  If this instrument has already been booted since 
PXI Studio was started, then the device is only reset. 

Once the instrument has been booted, you should see the following main screen: 

 
The Signal Generator front panel has tabs for RF Settings, Differential IQ, Arb Catalog, 
List Mode and Routing Matrix. 
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RF Settings tab 

 
This section of the Signal Generator front panel allows you to modify the basic RF and 
modulation state of the Signal Generator selected. 
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RF Settings 

 
This section is concerned only with basic CW operation parameters.  It consists of the 
following controls: 

Frequency 
This control allows you to modify the current RF frequency of the Signal Generator.  To edit 
the value, you can either use the step up and down arrows, or enter the frequency you require 
with appropriate units.  When editing the value, the background color of the control turns 
yellow to indicate that it has changed.  To apply any manual changes, press return.  To cancel 
your changes, press the escape key.  Note that once a change has been applied, the new 
settings are applied to the hardware. 

Valid units for this control are: 

GHz 

MHz 

kHz 

Hz 
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Level 
This control allows you to modify the current RF level of the Signal Generator.  To edit the 
value, you can either use the step up and down arrows, or enter the level you require.  When 
editing the value, the background color of the control turns yellow to indicate that it has 
changed.  To apply any manual changes, press return.  To cancel your changes, press the 
escape key.  Note that once a change has been applied, the new settings are applied to the 
hardware. 

Leveling Mode 
This control allows you to modify the current RF leveling mode of the Signal Generator.  The 
available options are Auto, Frozen, Peak and RMS. 

RMS Level 
This control allows you to modify the current RF level RMS of the Signal Generator.  To edit 
the value, you can either use the step up and down arrows, or enter the level RMS you require.  
When editing the value, the background color of the control turns yellow to indicate that it has 
changed.  To apply any manual changes, press return.  To cancel your changes, press the 
escape key.  Note that once a change has been applied, the new settings are applied to the 
hardware. 

Note that this parameter is only valid if the leveling mode is set to RMS. 

RF On/Off 
The RF State button allows you to toggle the RF output of the Signal Generator.  To enable or 
disable the RF output, click on this button.  Its state and color change to reflect the current 
state of the Signal Generator. 

Gate RF Off 
This check box allows you to specify whether RF gating is on or off.  To change the current 
state, simply check or uncheck the box; changes are applied to the hardware immediately. 
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RF gating is used to turn off the modulator when the modulation input level )Q(I 22 +  is 
near to zero.  This is particularly useful for bursted signals (for example, GSM) as the 
modulator’s natural carrier leak is removed for inactive timeslots. 
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Modulation 

 
This section allows you to specify the modulation mode, and settings of the Signal Generator. 

Modulation Source 
This control specifies the modulation source of the Signal Generator, the allowed options are: 

CW (No Mod) 

LVDS 

ARB 

Internal AM 

Internal FM 

External Analog 

Note that External Analog modulation is available only if you are using a 3020 Series module 
with the Differential IQ option enabled. 

To change the modulation source, use the drop down combo box and select the desired source: 
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When changing the modulation source, the settings for that modulation are now displayed in 
the modulation group box.  For instance, if you select a modulation source of LVDS, the 
modulation group looks like this: 

 
The control of each modulation is as follows: 
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LVDS modulation 

 
LVDS modulation is activated when changing the Modulation Source control to LVDS, and 
consists of the following controls: 

LVDS Sample Rate 
This control allows you to modify the current LVDS sample rate of the Signal Generator.  To 
edit the value, you can either use the step up and down arrows, or enter the LVDS sample rate 
you require.  When editing the value, the background color of the control turns yellow to 
indicate that it has changed.  To apply any manual changes, press return.  To cancel your 
changes, press the escape key.  Note that once a change has been applied, the new settings are 
applied to the hardware. 

Unsigned Data 
This check box allows you to specify whether LVDS data is signed or unsigned.  To change 
the current state, simply check or uncheck the box; the changes are applied to the hardware 
immediately. 

14 Bit Data 
This check box allows you to specify whether LVDS data is 14 or 16 bits.  To change the 
current state, simply check or uncheck the box; the changes are applied to the hardware 
immediately. 
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ARB Modulation 

 
ARB modulation is activated when changing the Modulation Source control to ARB, and 
consists of the following controls: 

Selected File 
This drop down combo box allows you to specify what Arb file you wish to play. 

Selecting a file 
To select a file, simply activate the dropdown box and select the file from the list, which 
contains the contents of the Arb catalog. 
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Adding a file 

If no files are currently present in your Arb catalog, you can activate the drop-down box and 
select Add New file.  This allows you to select and download an Arb file contained on a 
local drive.  Once the file has been loaded, it is then selected. 

Play 
The Play button allows you to toggle the Arb play state of the Signal Generator.  To start or 
stop an Arb file in continuous mode, click on this button.  Its state and color then change to 
reflect the current playing state.  To play an Arb file once in single-shot mode, click on this 
button. 

Note that this control is not available if there is no currently selected Arb file 

Single Shot/Continuous 
This button toggles the current Arb repeat mode of the Signal Generator.  This can be either 
single-shot or continuous.  Single-shot repeat mode indicates that the selected Arb file is 
played once; if in continuous mode, the Arb file is played continuously. 

Note that this control is not available if there is no currently selected Arb file. 
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External Trigger Mode: Disabled/Edge/Gate 
This control allows you to specify whether an Arb trigger is used and whether the Arb trigger 
is used solely for starting the Arb file (Edge) or whether an Arb trigger toggles the Arb 
playing state (Gated).  To change the current state, simply select the desired trigger type; the 
changes are applied to the hardware immediately. 

External Trigger Polarity: Positive/Negative 
This control allows you to specify whether the Arb is triggered by a positive or negative 
trigger transition.  To change the current state, simply select the desired edge type; the 
changes are applied to the hardware immediately. 
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Enhanced ARB Modulation 

 
ARB modulation is activated when changing the Modulation Source control to Enhanced 
ARB, and consists of the following controls: 
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Selected File 
This drop down combo box allows you to specify what Arb file you wish to play. 

Selecting a file 
To select a file, simply activate the dropdown box and select the file from the list, which 
contains the contents of the Arb catalog. 

 
Adding a file 

If no files are currently present in your Arb catalog, you can activate the drop-down box and 
select Add New file.  This allows you to select and download an Arb file contained on a 
local drive.  Once the file has been loaded, it is then selected. 
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Play 
The Play button allows you to toggle the Arb play state of the Signal Generator.  To start or 
stop an Arb file in continuous mode, click on this button.  Its state and color then change to 
reflect the current playing state.  To play an Arb file once in single-shot mode, or the required 
number of times in N-Times mode, click on this button.  Clicking this button when the Arb is 
playing or waiting for a trigger stops the Arb playing immediately. 

The display of this button indicates what is actually happening on the Arb: 

The Arb is not playing.  Clicking the button starts it playing (or starts it waiting for an external 
trigger). 

The Arb is waiting for an external trigger before starting to play the selected file.  Clicking the 
button cancels the Waiting for Trigger and returns the Arb to the stopped state. 

The Arb is currently playing the selected file.  Clicking the button stops the Arb file playing 
immediately and returns the Arb to the stopped state. 

The Arb is currently playing the selected file but it will stop playing at the end of the current 
file.  Clicking the button stops the Arb file playing immediately and returns the Arb to the 
stopped state. 

Note that this control is not available if there is no currently selected Arb file. 
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Terminate/Re-Start 
This button stops the Arb playing either immediately (when termination mode is set to 
Immediate) or when the current file has finished playing (when the termination mode is set to 
At End).  If an external trigger is being used, the Arb then waits for a trigger before starting 
again.  Otherwise, once the Arb is stopped, the Play button can be used to start it. 



SIGNAL GENERATOR FRONT PANEL 

61 

External Trigger – Mode 
This control sets the way in which the external trigger is used.  The following table describes 
the states that are available and their behavior: 

Play Mode Single/N Times Continuous 

Disabled The waveform starts playing immediately the Play 
button is pressed and stops when the file has been 
played the requisite number of times or the Play 
button is pressed again or the Terminate button is 
pressed. 

The waveform starts playing immediately the Play 
button is pressed and stops when the Play button 
is pressed again or the Terminate button is 
pressed. 

Gate The waveform starts playing, from the beginning 
when the trigger is asserted and plays the number 
of times specified. 

If it is still playing when it is aborted according to 
the termination mode. 

The waveform starts playing, from the beginning 
when the trigger is asserted and plays 
continuously. 

It is aborted according to the termination mode 
when the trigger is de-asserted. 

Start Only The waveform starts playing from the beginning 
when the trigger is asserted, plays the number of 
times specified, then stops, waiting for another 
trigger. 

Subsequent triggers are ignored until the waveform 
has finished playing. 

The waveform starts playing from the beginning 
when the trigger is asserted playing continuously. 

Subsequent triggers are ignored. 

Start Stop The waveform starts playing from the beginning 
when the trigger is asserted waiting for the trigger 
to be asserted a second time. 

If it is still playing when another trigger is detected 
playback is aborted according to the termination 
mode. 

The waveform starts playing from the beginning 
when the trigger is asserted, plays continuously 
until another trigger is detected at which point play 
is aborted according to the termination mode. 

Start 
Re-Trig 

The waveform starts playing from the beginning 
when a trigger is detected, plays the number of 
times specified, then stops, waiting for another 
trigger. 

Subsequent triggers terminate the waveform 
immediately, if playing, and the waveform starts 
playing from the beginning. 

The waveform starts playing from the beginning 
when a trigger is detected, and then plays 
continuously. 

Subsequent triggers terminate the waveform 
immediately, if playing, and the waveform starts 
playing from the beginning. 
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External Trigger – Polarity 
Positive 
A positive edge of the external trigger signal asserts the trigger. 

Negative 
A negative edge of the external trigger signal asserts the trigger. 

Any 
Any edge of the external trigger signal asserts the trigger. 

External Trigger – Delay 
This control is used to delay the trigger signal by up to 60 seconds.  Both edges of the trigger 
signal are effected equally. 

Changing the delay results in the loss of any trigger edges already being delayed. 

Play Mode – Termination 
Immediate 
When requested, either by the external trigger line, or by the Terminate/Re-Start button, the 
Arb terminates any playing file immediately. 

At End 
When requested, either by the external trigger line, or by the Terminate/Re-Start button, the 
Arb continues to play the current file until the end of the file is reached, at which point it stops 
playing. 
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Play Mode – Mode 
Single 
When requested to play, the Arb plays the selected file once and then stops. 

N Times 
When requested to play, the Arb plays the selected file the required number of times and then 
stops. 

Continuous 
When requested to play, the Arb starts playing the selected file repeatedly. 

Play Mode – Count 
This control is used to specify the number of times the Arb file is played when the play mode 
is set to N-Times. 

If the play mode is not set to N-Times, this control is not available. 
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Internal AM modulation 

 
Internal AM modulation is activated when you change the Modulation Source control to 
Internal AM, and consists of the following controls: 

Modulation Depth 
This control allows you to modify the current AM Modulation Depth of the Signal Generator.  
To edit the value, you can either use the step up and down arrows, or enter the AM 
modulation depth you require.  When editing the value, the background color of the control 
turns yellow to indicate that it has changed.  To apply any manual changes, press return.  To 
cancel your changes, press the escape key.  Note that once a change has been applied, the new 
settings are applied to the hardware. 
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Modulation Rate 
This control allows you to modify the AM Modulation Rate of the Signal Generator.  To edit 
the value, you can either use the step up and down arrows, or enter the AM modulation rate 
you require.  When editing the value, the background color of the control turns yellow to 
indicate that it has changed.  To apply any manual changes, press return.  To cancel your 
changes, press the escape key.  Note that once a change has been applied, the new settings are 
applied to the hardware. 
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Internal FM modulation 

 
Internal FM modulation is activated when you change the Modulation Source Control to 
Internal FM, and consists of the following controls: 

Deviation 
This control allows you to modify the current FM Deviation of the Signal Generator.  To edit 
the value, you can either use the step up and down arrows, or enter the FM deviation you 
require.  When editing the value, the background color of the control turns yellow to indicate 
that it has changed.  To apply any manual changes, press return.  To cancel your changes, 
press the escape key.  Note that once a change has been applied, the new settings are applied 
to the hardware. 
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Modulation Rate 
This control allows you to modify the FM Modulation Rate of the Signal Generator.  To edit 
the value, you can either use the step up and down arrows, or enter the FM modulation rate 
you require.  When editing the value, the background color of the control turns yellow to 
indicate that it has changed.  To apply any manual changes, press return.  To cancel your 
changes, press the escape key.  Note that once a change has been applied, the new settings are 
applied to the hardware. 
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External Analog modulation 

 
External Analog Modulation is activated when you change the Modulation Source Control to 
External Analog, and consists of the following controls: 

100 kOhm Termination / 50 Ohm Termination 
This group allows you to specify the termination resistance of the external analog inputs.  To 
change the current state, simply check the desired termination box.  The changes are applied 
to the hardware immediately. 

Calibrate Inputs 
This button allows you to perform a user calibration of the external analog inputs. 



SIGNAL GENERATOR FRONT PANEL 

69 

User Calibration 

 
This part of the RF Settings tab controls user calibration settings.  It consists of the following 
controls: 

Detector Zero 
Clicking this button performs a detector zero cal on the Signal Generator. 

IQ Spot Cal 
Clicking this button performs an IQ spot cal at the current frequency.  Note that this button is 
available only if the instrument is in an internal-IQ-based mode. 

Advanced… 
Clicking this button launches the advanced calibration screen, which allows you to calibrate 
different IQ bands individually. 
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Differential IQ tab 

 
This tab allows you to modify the Differential IQ settings of the instrument.  Note that these 
settings are not available if the Signal Generator does not have the Differential IQ Option 
fitted, and are not available if the modulation source is set to External Analog. 

Outputs 
This check box defines whether the differential IQ module is activated. 

Modulation 
This check box defines whether the IQ modulation source is connected to the differential IQ 
module. 

State 
This check box defines whether the differential IQ parameters are applied to the differential 
IQ module. 



SIGNAL GENERATOR FRONT PANEL 

71 

Level 
This control allows you to modify the differential IQ Level of the Signal Generator.  To edit 
the value, you can either use the step up and down arrows, or enter the differential IQ level 
you require.  When editing the value, the background color of the control turns yellow to 
indicate that it has changed.  To apply any manual changes, press return.  To cancel your 
changes, press the escape key.  Note that once a change has been applied, the new settings are 
applied to the hardware. 

Gain 
This control allows you to modify the differential IQ gain of the Signal Generator.  To edit the 
value, you can either use the step up and down arrows, or enter the differential IQ gain you 
require.  When editing the value, the background color of the control turns yellow to indicate 
that it has changed.  To apply any manual changes, press return.  To cancel your changes, 
press the escape key.  Note that once a change has been applied, the new settings are applied 
to the hardware. 

I Offset/Q Offset 
This control allows you to modify the differential IQ offset of the Signal Generator.  To edit 
the value, you can either use the step up and down arrows, or enter the differential IQ offset 
you require.  When editing the value, the background color of the control turns yellow to 
indicate that it has changed.  To apply any manual changes, press return.  To cancel your 
changes, press the escape key.  Note that once a change has been applied, the new settings are 
applied to the hardware. 
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I Bias/Q Bias 
This control allows you to modify the differential IQ bias of the Signal Generator.  To edit the 
value, you can either use the step up and down arrows, or enter the differential IQ bias you 
require.  When editing the value, the background color of the control turns yellow to indicate 
that it has changed.  To apply any manual changes, press return.  To cancel your changes, 
press the escape key.  Note that once a change has been applied, the new settings are applied 
to the hardware. 

Calibrate Output 
Clicking this button performs a calibration of the differential IQ outputs. 
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Arb Catalog tab 

 
The Arb Catalog tab allows you to modify and manage the Arb files that are loaded into your 
Signal Generator instrument. 

Adding file or files 
To add a file, or files, click the Add File button.  This brings up a file selection dialog where 
you can select the files that you want to load into the Signal Generator.  These files are then 
loaded into the Arb. 

Reloading a file 
To reload a file into your Signal Generator, select the file to reload from the Arb list, then 
click the Reload button. 

Removing a file 
To remove a file from your Signal Generator, select the file to remove from the Arb list, then 
click the Delete button. 
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Removing all files 
To remove all files within the Signal Generator, click the Delete All button to clear the Arb 
catalog. 

Reload All files 
To reload all files present within the Signal Generator, click the Reload All button. 
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List Mode tab 

 
The List Mode tab is concerned with setting up and running the Signal Generator in list mode.  
It is divided up into three sections. 
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List mode configuration 

 
This section allows you to modify the type of list mode used, common list parameters and 
control modes. 

Changing the list sequence mode 
To change the list sequence mode, select the required mode from the List Sequencing Mode 
down combo box.  When a selection has been made, the list parameters and settings are 
refreshed to the screen.  The available modes of operation are Arb Sequence Mode and 
Hopping Mode.  For detailed information on the individual modes, please refer to the 
afSigGenDll library documentation. 

Note that all separate modes of operation have their own individual settings, which means that 
changes made to one have no effect on the other. 
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Common list settings 
In Hopping Mode, there are a number of parameters that are generic across an entire 
sequence.  To modify these parameters, click on the Common List Settings button, if 
available.  This brings up the Common List Settings screen.  Note that this option is not 
available in Arb Sequencing mode. 

 



SIGNAL GENERATOR FRONT PANEL 

78 

Level Control 
This section dictates how level parameters are applied in the list.  The available control modes 
are Absolute and Relative. 

In Absolute control mode, the list level is in absolute dBm terms.  In Relative mode, the list 
level is relative (from 0 to –6 dB) to the base level entered in the Base Level edit box. 

Modulation Source 
This allows you to specify the modulation that is enabled when the list is running.  The 
available options are CW, ARB, Internal AM and Internal FM.  These modulation modes are 
edited in the same way as in the Modulation section of the RF Settings tab. 
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List mode control settings 
To modify the way the list is triggered and iterates, click on the List Mode Control button to 
bring up the List Mode Control dialog. 
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This dialog consists of the following controls: 

Address Source 
This control dictates what supplies the current list address; the options are Internal, Software 
and External. 

If the Address Source is set to Internal, the current list address is set by the internal counter, 
meaning that the list can only iterate sequentially. 

If the Address Source is set to Software, the current list address is set manually in the main 
List Mode tab 

If the Address Source is set to External, the current list address is set by a set of routing matrix 
signals.  If you select this address source, you have to specify exactly where the address 
comes from.  The available options for this are: LVDS, PXI Trigger Bus and Arb Markers. 

If the Address Source is set to Ext Serial, you have to specify which routing matrix signal is 
connected to the Serial Address signal.  The Signals available for this purpose are the PXI 
Trigger bus  signals 0 to 7, the LVDS Marker signals 1 to 4, the LVDS Aux signals 0 to 4, the 
LVDS Spare signals  0 to 2 and the Front Panel SMB connector. 

Note that this control is not available in Arb Sequence mode. 

Start Trigger Source 
Before your list can iterate, it must first be issued with a start trigger.  Where that trigger 
comes from is specified here.  The available options are Software or External. 

If External Start trigger is set, you also have to specify exactly where the trigger comes from.  
The available options for this are PXI Star or Front Panel SMB. 
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Step Trigger Source 
If you have Address Source: Internal selected, you need to specify where the trigger that 
causes the list to step to the next address comes from.  The available options are Software and 
Internal (Timer). 

In Internal (Timer) mode, the list is stepped after a certain timer period.  You enter this timer 
period in the List Parameter Entry section. 

In Software mode, the list is stepped manually from when the List Mode tab command is 
received. 

Note that this control is not available in Arb Sequence mode. 

List Repeat Mode 
This control specifies what the list does once it has completed iterating.  The available options 
are Once, N * Repeat and Continuous. 

In Once mode, the list halts after one iteration. 

In N * Repeat mode, the list halts after N iterations.  The value of N can be modified by 
using the Repeat Count control. 

Continuous means that the list iterates continuously. 

Start Address 
This control specifies the first address that is used in the sequence. 

Stop Address: 
This control specifies the last address that is used in the sequence. 

List Summary 
List Summary provides a basic description of how the list control you have defined works. 
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List parameter entry 

 
This section allows you to create and modify each individual channel’s parameters.  Each 
parameter can be individually edited by using either the mouse or the keyboard.  As well as 
basic in-line editing facilities, the list table also provides a number of more powerful features 
to ensure that creating or modifying a list is as simple as possible. 

The list itself consists of a total of 128 list addresses, with a number of parameters that are 
specific to each one.  The settable parameters available are as follows: 

In Arb sequence mode: 
Frequency 

This is the RF frequency at a given address. 

Level 
This is the RF level at a given address. 

Level Mode 
This is the RF leveling mode at a given address. 

Level RMS 
This is the RMS dbc level at a given address.  This parameter is enabled only when the list 
address level mode is RMS. 
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RF State 
This is the current RF enabled state for the given address. 

Arb Play Count 
This is the number of times the Arb plays before moving on to the next address. 

Arb File 
This is the Arb file that will be playing at the current address. 

In hopping mode: 
Frequency 

This is the RF frequency at a given address. 

Level 
This is the RF level at a given address.  Note that this parameter is available only if absolute 
control mode is selected. 

Relative Level 
This is the RF level relative to a base level at a given address.  Note that this parameter is 
available only if relative control mode is selected. 

Level Mode 
This is the RF leveling mode at a given address. 

RF State 
This is the current RF enabled state for the given address. 

Dwell Time 
This is the amount of time (in μs) that this list address is active before moving to the next 
address.  This parameter is valid only when in Internal list mode, using an Internal Timer 
step trigger. 
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Arb Modulation State 
This specifies whether the Arb modulation is enabled for this list address.  It is valid only if 
the list modulation mode is ARB. 

Editing a list address parameter 
It is important to note that the parameters being edited are not applied directly to the hardware 
at this time.  Applying values to the hardware only occurs when activating the list. 

To edit a list address parameter, press the enter key, space key or double-click on the item you 
want to edit in the list table.  This activates the edit mode for this item: 

 
You can then set the parameter to the desired value.  Once you are happy with your selection, 
press the enter key or click to apply the changes.  Alternatively, to reject the changes you have 
made, press the escape key to return the parameter to its original value. 
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Editing the frequency of a list address 

 
Once you have entered edit mode, you can use the up and down keys or arrow button to 
increase or decrease the value.  Alternatively, you can type the frequency you require with 
appropriate units.  When editing the value, the background color of the control turns yellow to 
indicate that it has changed.  To apply any manual changes, press return.  To cancel your 
changes, press the escape key. 

Valid units for this control are: 

GHz 

MHz 

kHz 

Hz 

Editing the level of a list address 

 
Once you have entered edit mode, you can use the up and down keys or arrow button to 
increase or decrease the value.  Alternatively, you can type the level you require.  When 
editing the value, the background color of the control turns yellow to indicate that it has 
changed.  To apply any manual changes, press return.  To cancel your changes, press the 
escape key. 
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Editing the relative level of a list address 

 
Once you have entered edit mode, you can use the up and down keys or arrow button to 
increase or decrease the value.  Alternatively, you can type the level you require.  When 
editing the value, the background color of the control turns yellow to indicate that it has 
changed.  To apply any manual changes, press return.  To cancel your changes, press the 
escape key. 

Editing the level mode of a list address 

 

Once you have entered edit mode, you can either use the up and down arrow keys to cycle 
through the available modes, or drop down the list of available options to cycle to the 
appropriate level mode.  The available modes are Auto, Peak and RMS. 
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Editing the RF state of a list address 

 
Once you have entered edit mode, you can either use the up and down arrow keys to cycle 
through the available modes, or drop down the list of available options to cycle to the 
appropriate RF state.  The available modes RF Off and RF On. 

Editing the Arb play count of a list address 

 
Once you have entered edit mode, you can use the up and down keys or arrow button to 
increase or decrease the value.  Alternatively, you can type the play count you require.  When 
editing the value, the background color of the control turns yellow to indicate that it has 
changed.  To apply any manual changes, press return.  To cancel your changes, press the 
escape key. 
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Editing the Arb file used by a list address 

 
Once you have entered edit mode, you can either use the up and down arrow keys to cycle 
through the available Arb files, or drop down the list of available options to cycle to the 
appropriate files.  If no files are currently present in your Arb catalog, you can activate the 
drop-down box and select Add New File.  This allows you to select and download an Arb file 
contained on a local drive.  Once the file has been loaded, it is then selected. 

Editing the dwell time of a list address 

 
Once you have entered edit mode, you can use the up and down keys or arrow button to 
increase or decrease the value.  Alternatively, you can type the dwell time you require.  When 
editing the value, the background color of the control turns yellow to indicate that it has 
changed.  To apply any manual changes, press return.  To cancel your changes, press the 
escape key. 
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Editing the Arb state of a list address 

 
Once you have entered edit mode, you can either use the up and down arrow keys to cycle 
through the available modes, or drop down the list of available options to cycle to the 
appropriate Arb state.  The available modes are Arb Off and Arb On. 
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Advanced list mode editing 
As well as basic parameter entry, the list table also provides you with the ability to perform 
more complicated editing tasks.  Most of these features can be accessed via right-clicking on 
the list table. 

 
This menu is split up into two parts.  The generic section is always displayed when you right-
click on the table.  The parameter-specific part only displays options for parameters that have 
been selected.  For instance, if you select a frequency and a level, only frequency and level 
sub-menus are available.  The above menu has ALL parameters selected. 



SIGNAL GENERATOR FRONT PANEL 

91 

Generic menu functions 
Copy 

This copies the selected list parameters and address into the clipboard.  Note that the format 
of the data pasted into the clipboard is compatible with text applications, as well as 
Microsoft Excel. 

Paste 
This pastes the contents of the clipboard into the list at the selected position.  Note that if the 
clipboard data is not valid for this list, paste is not available. 

Paste Linked 
It is sometimes useful to have the ability to make a parameter of a particular address taking 
the value of another; so that if you change the value of one cell, both are updated.  
Performing a linked paste ties the value of the location from which you copied to the 
location to which you paste.  This means that whenever you change the former, the latter 
takes the same value. 

Break Link 
Breaks the link mentioned above. 

Select all 
Selects ALL list addresses for the selected parameters. 
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Parameter-specific menu functions 
Setting all addresses to a value 

This takes the selected parameter value and applies it to all 128 channels. 

Create Sweep 
It is sometimes useful to increase or decrease the values of a list parameter sequentially.  
Clicking this menu item displays the following screen that allows you to do this: 

 
Start Address 

This specifies the first address to which the sweep is applied. 

Stop Address 
This specifies the last address to which the sweep is applied. 

Start Level 
This specifies the first level of the sweep. 

Step Level 
This specifies the step value of the sweep. 
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Once you have entered the values you want, click Ok to apply the changes into the list, or 
Cancel to reject the changes and return to the list table. 

 Note: Create Sweep is only available for frequency and level parameters. 

Adjust All Values 
It is sometimes useful to increase or decrease the values of a list parameter by a given 
amount.  The Adjust All Values menu item displays the following screen that allows you to 
do this: 

 
The value you enter in this screen is added to all selected addresses for the given parameter. 

List mode control 
Once you have set up all your list parameters and control settings, this section allows you to 
actually start your list playing. 

 
Before you start the list, you need to select how the list is initialized. 

Train to Peak 
This specifies whether the list is trained using RMS or Peak leveling mode. 
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Train on List Start 
This specifies whether the list will be trained before it is started.  Training initializes the 
hardware for fast-level transitions. 

Freeze after Train 
This specifies whether the list is frozen after it has been trained.  This ensures that the level is 
frozen once it has initialized.  This is recommended if you are using an Arb file that contains 
long periods with no IQ. 

Starting your list 
Once you have selected how to initialize your list, you can then click the Start List button, 
which first updates all of the parameters you have entered to the hardware and then, if 
specified, trains and freezes the hardware. 

If you have specified a software start trigger, starting the list automatically issues the first step 
trigger, meaning that the list starts iterating immediately. 

The following screen demonstrates a running list: 
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When the list is activated, you are still able to modify both common list settings and list mode 
control settings; however, these values are not applied to the hardware until you restart the 
list.  Also, when the list is activated, the list table is disabled. 

As the list iterates, the table automatically selects the current address of the hardware.  
However, if the list iterates rapidly, not all address transitions are captured, meaning that the 
address may appear to jump over one or more addresses. 

Stopping the list 
To stop the list, simply press the green Stop List button, which returns the list to its idle state 
and allows you to continue editing list parameters. 

Restarting the sequence 

 
If you are in single or N * repeat mode in combination with Internal Arm trigger, the list stops 
iterating after the specified number of list repeats.  At this time, the list is still active, but not 
currently iterating.  To retrigger the list, click the Restart Sequence button. 

Stepping the sequence 

 
If you are in Internal Step trigger mode, the list does not automatically iterate to the next 
address in the sequence.  To step the sequence, click the Step Sequence button, which causes 
the sequence to move to the next address.  Note that once the list has completed all of its 
iterations (as specified by repeat mode), clicking Step Sequence restarts the list. 
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Setting the current address 

 
If you have specified Software Address source in your List Control settings, you are able to 
specify the current active address once the list has been started.  This can be done by 
modifying the Address control. 

Once you have selected this control, you can use the up and down keys or arrow button to 
increase or decrease the value.  Alternatively, you can type the address you require.  When 
editing the value, the background color of the control turns yellow to indicate that it has 
changed.  To apply any manual changes, press return.  To cancel your changes, press the 
escape key.  Note that this address is immediately set in the hardware. 
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Routing Matrix tab 

 
The Routing Matrix tab provides a graphical way of controlling how the internal routing 
matrix of the instrument is configured.  It allows you to view, add, or modify how all the 
internal routing is connected. 

The screen consists of two parts.  On the left is the routing canvas, where all your connections 
are edited and displayed; on the right is a list of available groups that you can route. 
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Adding a group 
To add a routing group to your routing canvas, simply select the item you wish to add from 
the routing list.  Then hold down the left mouse button and drag the item onto the routing 
canvas.  When you release the left mouse button, the graphical representation of this group 
appears on the routing canvas. 
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Each routing group contains one or more connection points, which represent the individual 
routing matrix signals to which or from which you can connect.  These signals can have three 
types: 

A routing line that can only be used to drive another line is represented like this: 

 
A routing line that can only be driven from another line is represented like this: 

 
A routing line that is bidirectional, in that it can drive or be driven by another line, is 
represented like this: 

 
If the routing group has more than one line (for example, the PXI Trigger bus group has eight 
individual lines) then the group will contain a master bus connection point, represented like 
this: 

 

Moving a group 
Once you have placed a group on the routing canvas, you can move it around by left-clicking 
on the top of the control, and dragging it to the desired location. 

Removing a group 
To remove a group that has been added to the routing canvas, you can right-click on the top of 
the control, and select Delete; this removes the item from the routing canvas, as well as 
deleting any connections that have been made. 
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Connecting two signals 
To connect two signals together, first move your mouse over the connection point you wish to 
connect; the graphical representation should now highlight in green to show that it is selected.  
Next, left-click on this.  You should now see a line joining this connection point to your 
mouse cursor.  Finally, left-click on the connection point to which you want to connect.  Once 
you have done this, the routing canvas should now show the connection between the two 
points: 

 
This connection shows that PXI Trigger Bus 0 is now connected to Arb Marker1.  Once the 
connection is made, the hardware is automatically updated to reflect the change. 

You may also note that as PXI Trigger Bus 0 is now connected to an output signal 
(Arb Marker1), the signal type has changed from ‘bidirectional’ to ‘input’. 

As you can see, however, the position of the individual connection points makes the route a 
little cluttered.  In order to make a cleaner connection, you can change the orientation of the 
connection points within the routing group. 
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Changing the position of all ports 
To change the position of all the connection point in the routing group, right-click on the top 
of the routing group, and select Flip ports from the drop-down menu.  This moves all ports on 
the left of the routing group to the right, and vice versa: 

 
Alternatively, to change the position of an individual connection point, right-click on the 
connection point and select Flip port. 

Removing a connection 
To remove a connection you have previously made, right-click on the connection point you 
want to disconnect and select Clear connections.  Alternatively, if you want to remove all 
connections from a routing group, right-click at the top of the routing group and select 
Clear all connections.  This disconnects all ports within this group. 
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Bus connections 
In some cases, you may want to connect entire groups together.  The routing canvas allows 
you to do this by using the master bus signal. 

If you want do a bulk connection, connect the two master bus connection points of the two 
routing groups you want to connect in the same way as you connected individual routing 
points mentioned earlier. 

 
As you can see, the two master bus connection points are now connected, as are the individual 
lines.  Connecting in this way causes as many lines to be connected as possible from top to 
bottom.  Note that disconnecting the master bus connection point causes all other connections 
to be cleared too. 
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Hiding connection points 
When a routing group contains a master bus connection point, it is possible to hide all other 
connection points in order to simplify the routing canvas.  To do this, simply right-click on the 
routing group and check the Show as single line item.  Alternatively, to show all lines that are 
available, uncheck this Show as single line item. 

Note that if you have two groups connected together using the master bus connection point, 
and all of its connection points are shown, the connections are only drawn to and from the 
master bus connection points; individual lines are shown as unconnected. 

Other symbols 

Route overlap: 

 
This indicates that a connection line crosses over another. 

Route connection 

 
This indicates that the two routing lines are connected together at this point. 

 
This indicates that while there is a hardware connection from this line, there is not enough 
available space to draw it on the routing canvas. 
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Connection errors 
It is not always possible to connect two connection points together.  In these situations, an 
error message box is displayed, showing you what went wrong. 

The reasons for being unable to make a connection are as follows: 

 You are trying to connect an input to an input. 

 You are trying to connect an output to an output. 

 You are trying to connect multiple output signals to an input. 

 You are attempting use a PXI backplane signal (PXI Trigger bus / PXI Star / PXI LBL) 
as an input (that is, you are trying to drive the PXI backplane), but there is already 
another device that has ownership of the backplane. 

In cases where you are trying to connect a bidirectional connection point to another 
bidirectional routing point, you are asked to specify which you want to configure as an output 
and which as an input. 
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Chapter 4   
Digitizer front panel 

Overview 
The Digitizer Front Panel plugin allows you to set up and control a Digitizer Instrument 
(3030 Series and 3010 Series PXI modules). 

To open the Digitizer front panel, click Instrument Control on the top-level PXI Studio 
menu, and select Digitizer Front Panel. 

If this entry does not appear on the top level menu, select Tools -> Registered Plugins and add 
the plugin afDigitizerPlugin.dll. 

When opening the Digitizer Front Panel, if there is only one digitizer instrument available in 
your system, it is automatically selected and booted.  Otherwise, you are asked to select which 
instrument you wish to control: 
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This screen provides a list of ‘logical instruments’ that you have defined in your System 
Configuration, which match the type you have requested.  Note that instruments that are 
currently in use by other plugins do not appear in this list. 

Click on the name of the instrument you wish to use, and click Ok.  Alternatively, if you do 
not wish to proceed to the digitizer front panel, or the hardware you wish to control is not 
present in the list, click Cancel. 

Once you click Ok, the instrument and other instruments that comprise your frequency 
standard (depending on the frequency standard configuration defined in System 
Configuration) are booted if required.  If this instrument has already been booted since 
PXI Studio was started, then the device is only reset. 
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Once the instrument has been booted, you should see the following main screen: 

 

This front panel screen contains panels for Input Settings, Capture Settings and 
IQ Capture Display.  For information about how to manipulate these panels in order to create 
a customized layout, see Common Plugin Control. 
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The RF Settings panel 

 
This panel is responsible for setting the basic RF Input settings of the Digitizer instrument.  It 
consists of the following controls: 
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RF Centre Frequency 
This control allows you to modify the current RF center frequency of the Digitizer.  To edit 
the value, you can use the up and down keys or arrow button to increase or decrease the value.  
Alternatively, you can type the frequency you require with appropriate units.  When editing 
the value, the background color of the control turns yellow to indicate that it has changed.  To 
apply any manual changes, press return.  To cancel your changes, press the escape key. 

Valid units for this control are: 

GHz 

MHz 

kHz 

Hz 

Loop Bandwidth 
Specifies whether the LO is in Normal or Narrow loop bandwidth mode. 

LO Position 
This control allows you to specify whether the 3010 Series module’s local oscillator supplies 
a frequency that is above or below the RF center frequency.  If an RF center frequency is 
specified that the LO cannot provide using its current position, the LO Position is changed. 
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Mode 
Specifies the input level setting mode.  The available options are: 

Auto 
The attenuation and, on modules that support it, the Pre-Amp settings are automatically set 
based on the specified input level. 

Auto IF 
The IF attenuation is automatically set from the specified input level, taking into account the 
specified RF attenuation and Pre-Amp state. 

Manual 
The IF attenuation, the RF attenuation and, on modules that support it, the Pre-Amp state are 
all manually set.  The Input level control indicates the approximate maximum power level that 
can to applied to the input without overloading the input. 

Input Level 
This control allows you to modify the current input level of the Digitizer.  To edit the value, 
you can use the up and down keys or arrow button to increase or decrease the value.  
Alternatively, you can type the reference level you require with appropriate units.  When 
editing the value, the background color of the control turns yellow to indicate that it has 
changed.  To apply any manual changes, press return.  To cancel your changes, press the 
escape key. 

RF Atten 
This control sets the RF Attenuation when the level mode is set to Auto IF or Manual.  When 
the level mode is set to Auto, the control can not be used but it indicates the current 
attenuation value. 



DIGITIZER FRONT PANEL 

111 

IF Atten 
This control sets the IF Attenuation when the level mode is set to Manual.  When the level 
mode is set to Auto or Auto IF, the control can not be used but it indicates the current 
attenuation value. 

Pre Amp 
This control sets the RF Pre-Amp state when the level mode is set to Manual or Auto IF.  
When the level control mode is set to Auto, this control can not be used but it indicates the 
current pre-amp state. 

This control does not appear when the module employed does not allow RF Pre Amp control. 
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The Capture Settings panel 

 
This panel allows you to set up and perform capture as well as providing the ability to store 
the resulting data.  This panel consists of the following controls: 
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Sampling Frequency 
This control allows you to modify the current sampling frequency of the Digitizer.  To edit the 
value, you can use the up and down keys or arrow button to increase or decrease the value.  
Alternatively, you can type the sampling frequency you require with appropriate units.  When 
editing the value, the background color of the control turns yellow to indicate that it has 
changed.  To apply any manual changes, press return.  To cancel your changes, press the 
escape key. 

Valid units for this control are: 

MHz 

kHz 

Hz 

Capture Duration (Time) 
If you want to specify your capture length in terms of time, you need to enable this check box.  
Doing so enables the time duration entry box. 

The time duration entry box allows you to modify the current capture duration of the capture 
with respect to time.  To edit the value, you can use the up and down keys, or arrow button to 
increase or decrease the value.  Alternatively, you can type the time you require with 
appropriate units.  When editing the value, the background color of the control turns yellow to 
indicate that it has changed.  To apply any manual changes, press return.  To cancel your 
changes, press the escape key. 

Note: if you specify a capture duration in terms of time and then change your sampling 
frequency, the duration of the capture remains unchanged, but the capture duration in 
samples changes. 
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Capture Duration (Samples) 
If you want to specify your capture duration in terms of samples, you need to enable this 
check box.  Doing so enables the Sample duration entry box. 

The Sample duration entry box allows you to modify the current capture duration of the 
capture with respect to samples.  To edit the value, you can use the up and down keys or 
arrow button to increase or decrease the value.  Alternatively, you can type the number of 
samples you require with appropriate units.  When editing the value, the background color of 
the control turns yellow to indicate that it has changed.  To apply any manual changes, press 
return.  To cancel your changes, press the escape key. 

Note: if you specify a capture duration in terms of samples and then change your sampling 
frequency, the duration of the capture in samples remains unchanged, but the capture 
duration in time does change. 

Sample Resolution Mode 
This control allows the control of the capture resolution.  It can either be set to Auto 16 32 Bit, 
in which case the capture resolution is automatically set according to the sample rate, or 
Fixed 16 Bit.  High sample rates dictate 16-bit captures while low sample rates can utilize 32-
bit transfers.  When supported, 32-bit transfers give better noise and dynamic range at the 
expense of a higher transfer time. 

Dither 
This control enables or disables the use of Dithering on modules that support it.  The control 
does not appear if the module does not support control over dithering. 

Dither is a technique where a noise-like signal, uncorrelated with the wanted signal, is added 
to the Analog-to-Digital Converter (ADC) input.  This has the effect of smoothing out the 
nonlinearities and can give improvements in ADC noise floor, distortion products and level 
linearity. 
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Start/Stop Capture 
This button toggles the current state of your capture.  If you are not capturing, this control is 
colored red and labeled Start Capture; if you are capturing, this control is colored green and 
labeled Stop Capture.  To toggle the state, simply click on this button, and the capture starts 
and stops accordingly. 

Repeat/Single 
This button toggles the current repeat state of your capture.  This can either be single, or 
repeated.  Single repeat mode indicates that only one capture is performed; if in repeat mode, 
the Digitizer is immediately re-armed after a capture, allowing you to capture continuously 
until you decide to stop. 
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Save Data 
If you have capture information available and provided you are not in continuous capture 
mode, you have the ability to export the data you have captured to a file.  To export the data, 
click Save Data, and the following screen is displayed: 

 

Selecting a file 
To select a file, click the Browse button.  This allows you to specify the filename and location 
to save your data to. 
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File Types 
This control specifies the type of file that is exported.  The Digitizer front panel can export IQ 
in two separate types: 

User IQ File: this IQ data format is compatible with ® user files. 

VSA IQ File: this format is compatible with Agilent VSA software. 

As well as this, there are a number of sub formats available; these are applicable only when in 
User IQ File type.  These are the standard file formats supported by ®. 

In either mode, you have the option to write header information.  This specifies whether extra 
information about the IQ data, such as sample rate and adjustment factor, is included in the 
file. 

You need to check this option if you want to export data for use with the Agilent VSA 
software. 

If you are using a User IQ File format with the intention of exporting the data into 
®, you should not check this box. 

If you click Save the IQ file is immediately saved to file. 
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Triggering 
This button displays the trigger settings screen, which allows you to modify how your capture 
is triggered: 
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Trigger Mode 

 

To change the mode, simply activate the drop-down combo box labeled Trigger Mode, and 
select the desired trigger mode: 

This control allows the selection of the Trigger Mode.  There are either four or five trigger 
modes available depending on the af303x variant used: 

Software 
In Software trigger mode, the capture is automatically triggered whenever a request for a new 
capture is made. 

External 
In External trigger mode, the capture is triggered by a predefined routing matrix signal. 

Internal IF 
In Internal IF trigger mode, the capture is triggered by an internal trigger mechanism based on 
the IF data from a user-specified threshold.  This is always a wide-bandwidth trigger. 
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Internal IQ 
In Internal IQ trigger mode, the capture is triggered by an internal trigger mechanism based on 
the IQ data from a user-specified threshold.  The bandwidth of the signal from which the 
trigger is obtained will never exceed the sampling rate.  IQ Triggering will only be available 
on modules that support it. 

Timer 
In Timer trigger mode, the capture is triggered by an internal trigger mechanism derived from 
a hardware timer. 



DIGITIZER FRONT PANEL 

121 

External Trigger Mode 
Changing to External trigger mode provides more triggering options as shown below: 

 
For External trigger mode, the following controls are available: 

External Trigger Source 
This controls where the external trigger comes from.  The options are: 

PXI Trigger Bus 0–7 

PXI Star 

PXI Local Bus Left 0–12 

LVDS Aux 0–4 

LVDS Spare 0 

LVDS Marker 0–4 

Front Panel SMB 
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External Trigger Settings 
The Trigger settings section is available whenever you use a non-software trigger.  It consists 
of the following controls: 

Trigger Type 
This specifies how the trigger is processed.  The available options are Gated and Edge. 

Edge mode causes a capture to start when the trigger is received, and captures the number of 
samples you specify in the main capture settings panel. 

Gated mode causes a capture to start when the trigger is received and stops capturing when a 
second trigger is received, or when the number of samples specified in the main capture 
settings panel have been captured. 

Trigger Polarity 
This specifies what type of edge is used to trigger on.  The options are Positive and Negative. 

Trigger Delay: 
This control allows you to specify the number of samples between when a trigger is received 
and when the capture is started.  If this value is negative, the capture includes the specified 
number of samples before the trigger point. 

Post-Trigger Delay: 
In gated trigger type, this control allows you to specify how many samples to capture after the 
stop trigger is received. 

Hold off 
Hold off controls the rate at which triggers are handled.  Once a capture is triggered, the hold 
off period specifies an amount of time before any more triggers can be accepted. 
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Internal IF Trigger Mode 
Changing to Internal IF trigger mode shows more triggering options as shown below: 
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For Internal Trigger mode, the following controls are available: 

Internal Trigger Source 
This specifies what internal trigger to use. 

Internal Trigger 
This specifies that the Digitizer is triggered by an internal threshold. 

Internal Timer 
This specifies that the Digitizer is triggered by an internal timer trigger. 

Trigger Settings 
The Trigger settings section is available whenever you use a non-software trigger.  For details 
on the Trigger Settings section, refer to External Trigger Mode. 

Internal Trigger Settings 
When using an internal trigger source, this section allows you to specify the settings of the 
internal threshold triggering system. 
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Internal Trigger Mode 
This control specifies whether you use a relative or absolute triggering mode. 

Internal Trigger Absolute 
In Absolute mode, if the input level of the Digitizer rises above the absolute threshold 
specified, a trigger is issued and a capture begins. 

 
Absolute Threshold 
This specifies the level to trigger at. 

Absolute Time Constant 
In order to prevent minor blips from setting off a trigger, or if you want to trigger when the 
signal is above a particular threshold for a moment in time, there is a time constant applied to 
the threshold.  Increasing this time constant increases the amount of time the input level has to 
exceed the threshold in order to activate the trigger. 
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Internal Trigger Relative 
In Relative mode, if the input level of the Digitizer changes by more than the relative 
threshold, a trigger is issued and a capture begins. 

 
Relative Threshold 
This control specifies the change in level required to activate a trigger. 

Fast Time Constant/Slow Time Constant 
As in Absolute threshold mode, it maybe necessary to prevent minor blips from setting off a 
trigger, or if you want to trigger when the signal is above a particular threshold for a moment 
in time. 

To do this, the Digitizer compares the RF input level through two different filters, one with a 
fast time constant, one with a slow time constant.  If the difference between the two is greater 
than the threshold specified, the trigger is activated. 
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Internal IQ Trigger Mode 
Internal IQ Trigger Mode is only available on af303xC variants.  

Changing to Internal IQ trigger mode shows more triggering options as shown below: 
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For Internal Trigger mode, the following controls are available: 

Internal Trigger Source 
This specifies what internal trigger to use. 

Internal Trigger 
This specifies that the Digitizer is triggered by an internal threshold. 

Internal Timer 
This specifies that the Digitizer is triggered by an internal timer trigger. 

Trigger Settings 
The Trigger settings section is available whenever you use a non-software trigger.  For details 
on the Trigger Settings section, refer to External Trigger Mode. 

Internal Trigger Settings 
When using an internal trigger source, this section allows you to specify the settings of the 
internal threshold triggering system. 
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Internal Trigger Mode 
This control specifies whether you use a relative or absolute triggering mode. 

Internal Trigger Absolute 
In Absolute mode, if the input level of the Digitizer rises above the absolute threshold 
specified, a trigger is issued and a capture begins. 

 
Absolute Threshold 
This specifies the level to trigger at. 

Absolute Time Constant 
In order to prevent minor blips from setting off a trigger, or if you want to trigger when the 
signal is above a particular threshold for a moment in time, there is a time constant applied to 
the threshold.  Increasing this time constant increases the amount of time the input level has to 
exceed the threshold in order to activate the trigger. 
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Internal Trigger Relative 
In Relative mode, if the input level of the Digitizer changes by more than the relative 
threshold, a trigger is issued and a capture begins. 

 
Relative Threshold 
This control specifies the change in level required to activate a trigger. 

Fast Time Constant/Slow Time Constant 
As in Absolute threshold mode, it maybe necessary to prevent minor blips from setting off a 
trigger, or if you want to trigger when the signal is above a particular threshold for a moment 
in time. 

To do this, the Digitizer compares the RF input level through two different filters, one with a 
fast time constant, one with a slow time constant.  If the difference between the two is greater 
than the threshold specified, the trigger is activated. 
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Timer 
If you set the internal trigger source to Internal Timer, it means that a trigger is issued 
according to the internal timer settings you specify. 

If you set the internal trigger source to Internal Timer, the following section becomes active: 

 
This section consists of the following controls: 

Timer Period 
This control specifies the time (in μs) between triggers being issued 

Timer Phase 
This control adjusts the phase of the internal timer signal in multiples of the re-sampled 
sample clock periods. 
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The LVDS Settings Panel 

 
This panel allows you to control the LVDS signaling.  This panel consists of the following 
controls: 

Data/Spare0 Mode 
Controls the signaling on the LVDS data lines and the LVDS Spare0 line.  Valid states are 
Tri-State, Input and Output. 

Marker Mode 
Controls the signaling on the four LVDS marker lines.  Valid states are Tri-State, Input and 
Output. 
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Auxiliary Mode 
Controls the signaling on the five LVDS auxiliary lines.  Valid states are Tri-State, Input and 
Output.  

Clock State 
This control is used to enable and disable the LVDS data clock when used with hardware 
driver versions that support this feature. 

If the installed drivers do not support the functionality to set the LVDS clock state, this 
control is not present. 
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Measurement toolbar 

 
The Measurement toolbar allows you to view the overall status of the measurement or 
measurements that are currently in progress.  It consists of the following sections: 

ADC Status 
This section displays whether the ADC of the Digitizer in use was flagged as being 
overloaded at any stage of the measurement.  If the ADC was overloaded, this section changes 
color to red. 

Measurement Status 
This section of the tool bar displays the current status of the digitizer. 
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IQ Capture Display 

 
This panel is responsible for displaying the results of any IQ capture that is performed using a 
Graph Display panel.  For more details on the standard control of Graph Display Panels, see 
Common Plugin Control. 

Resetting the Displayed Samples 
As it is possible to display different sections of  IQ samples in the IQ vector display; this 
function allows you to reset the display so that it uses all of the available IQ samples.  To reset 
the samples being displayed, access the Trace Controls menu by right-clicking on the graticule 
and select Reset Samples. 
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Display Types 
As well as being able to display a simple IQ vector as shown above, a number of different 
graph types are available.  To change the display type, click on the menu at the top of the 
graphical display, which shows a number of different options: 

IQ vs Time 

 
This mode displays the I and Q parts of the captured data overlaid on the same plot. 
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Power vs Time 

 
This mode displays the power of the captured data versus time. 
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Phase vs Time 

 
This mode displays the phase of the captured data vs time. 
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Freq vs Time 

 
This mode displays the frequency offset of the captured data versus time. 
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IQ FFT 

 
This mode displays a spectral analysis of the captured data.  When in this mode, the FFT size 
is the closest power of 2 that is less than, or equal to the number of samples you have 
specified; up to a maximum of 65536.  If the number of samples available is greater than the 
FFT size, then multiple FFTs are performed and the results are averaged together.  Thus all of 
the presented samples contribute to some degree to the generated spectrum display. 

When the display area is large enough, the display is annotated with the Equivalent Noise 
Bandwidth (NBW), the 6 dB Resolution Bandwidth (RBW), the FFT size employed, the 
Windowing state and the sample range presented to the FFT analysis. 
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Resetting the FFT 
As it is possible to FFT different sections of IQ samples; this function allows you to reset the 
FFT so that it uses the default IQ Samples.  To reset the samples being FFT’ed, access the 
Trace Controls menu by right-clicking on the graticule and select Reset FFT. 

Selecting the FFT window 
If is possible to choose between a windowed and a non-windowed FFT.  To choose whether or 
not to use windowing, access the Trace Controls menu by right-clicking on the graticule and 
select or deselect Apply Window. 
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Other points of note for the IQ Capture Display panel 

Changing the sampling frequency. 
If you change the sampling frequency whilst performing a capture; the sample zoom factor of 
all graphs is reset. 

Changing the number of samples 
If you change the number of capture samples, in time or in samples, the zoom factor of all 
graphs is reset. 

Changing the way large captures are displayed 
You can choose how very large captures are displayed.  By default all selected samples are 
displayed.  However, this can result in poor display performance when the number of samples 
becomes very large because of the amount of work that has to be done and the amount of 
memory that has to be employed.  Consequently, there is an option on all trace types except 
IQ FFT to decimate the samples before display such that only every Nth sample is displayed, 
where N is chosen to give no more than 10000 display points. 

Sample decimation should not be used when viewing signals with short duration bursts since 
the decimation may hide the burst.  Conversely, enabling sample decimation on older, 
resource-limited computers may help improve the usability of the digitizer front panel when 
working with signals that do not have such short duration pulses. 

To choose whether or not to use windowing, access the Trace Controls menu by right-clicking 
on the graticule and select or deselect ‘Decimate Samples’ 

Note: Earlier versions (1.8.0 and prior) of the digitizer front panel always used sample 
decimation to limit the displayed points to no more than 3000. 
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Routing Matrix tab 

 
The Routing Matrix tab provides a graphical way of controlling how the internal routing 
matrix of the instrument is configured.  It allows you to view, add, or modify how all the 
internal routing is connected. 

The screen consists of two parts.  On the left is the routing canvas, where all your connections 
are edited and displayed; on the right is a list of available groups that you can route. 
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Adding a group 
To add a routing group to your routing canvas, simply select the item you wish to add from 
the routing list.  Then hold down the left mouse button and drag the item onto the routing 
canvas.  When you release the left mouse button, the graphical representation of this group 
appears on the routing canvas. 

 
Each routing group contains one or more connection points, which represent the individual 
routing matrix signals to which or from which you can connect.  These signals can have three 
types: 

A routing line that can only be used to drive another line is represented like this: 
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A routing line that can only be driven from another line is represented like this: 

 
A routing line that is bi-directional, in that it can drive or be driven by another line, is 
represented like this: 

 
If the routing group has more than one line (for example, the PXI Trigger bus group has eight 
individual lines) then the group will contain a master bus connection point, represented like 
this: 

 

Moving a group 
Once you have placed a group on the routing canvas, you can move it around by left-clicking 
on the top of the control, and dragging it to the desired location. 

Removing a group 
To remove a group that has been added to the routing canvas, you can right-click on the top of 
the control, and select Delete; this removes the item from the routing canvas, as well as 
deleting any connections that have been made. 
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Connecting two signals 
To connect two signals together, first move your mouse over the connection point you wish to 
connect; the graphical representation should now highlight in green to show that it is selected.  
Next, left-click on this.  You should now see a line joining this connection point to your 
mouse cursor.  Finally, left-click on the connection point to which you want to connect.  Once 
you have done this, the routing canvas should now show the connection between the two 
points: 

 
This connection shows that PXI Trigger Bus 0 is now connected to Arb Marker1.  Once the 
connection is made, the hardware is automatically updated to reflect the change. 

You may also note that as PXI Trigger Bus 0 is now connected to an output signal 
(Arb Marker1), the signal type has changed from ‘bidirectional’ to ‘input’. 

As you can see, however, the position of the individual connection points makes the route a 
little cluttered.  In order to make a cleaner connection, you can change the orientation of the 
connection points within the routing group. 
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Changing the position of all ports 
To change the position of all the connection point in the routing group, right-click on the top 
of the routing group, and select Flip ports from the drop-down menu.  This moves all ports on 
the left of the routing group to the right, and vice versa: 

 
Alternatively, to change the position of an individual connection point, right-click on the 
connection point and select Flip port. 

Removing a connection 
To remove a connection you have previously made, right-click on the connection point you 
want to disconnect and select Clear connections.  Alternatively, if you want to remove all 
connections from a routing group, right-click at the top of the routing group and select 
Clear all connections.  This disconnects all ports within this group. 
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Bus connections 
In some cases, you may want to connect entire groups together.  The routing canvas allows 
you to do this by using the master bus signal. 

If you want do a bulk connection, connect the two master bus connection points of the two 
routing groups you want to connect in the same way as you connected individual routing 
points mentioned earlier. 

 
As you can see, the two master bus connection points are now connected, as are the individual 
lines.  Connecting in this way causes as many lines to be connected as possible from top to 
bottom.  Note that disconnecting the master bus connection point causes all other connections 
to be cleared too. 
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Hiding connection points 
When a routing group contains a master bus connection point, it is possible to hide all other 
connection points in order to simplify the routing canvas.  To do this, simply right-click on the 
routing group and check the Show as single line item.  Alternatively, to show all lines that are 
available, uncheck this Show as single line item. 

Note that if you have two groups connected together using the master bus connection point, 
and all of its connection points are shown, the connections are only drawn to and from the 
master bus connection points; individual lines are shown as unconnected. 

Other symbols 

Route overlap: 

 
This indicates that a connection line crosses over another. 

Route connection 

 
This indicates that the two routing lines are connected together at this point. 

 
This indicates that while there is a hardware connection from this line, there is not enough 
available space to draw it on the routing canvas. 



DIGITIZER FRONT PANEL 

150 

Connection errors 
It is not always possible to connect two connection points together.  In these situations, an 
error message box is displayed, showing you what went wrong. 

The reasons for being unable to make a connection are as follows: 

 You are trying to connect an input to an input. 

 You are trying to connect an output to an output. 

 You are trying to connect multiple output signals to an input. 

 You are attempting use a PXI backplane signal (PXI Trigger bus / PXI Star / PXI LBL) 
as an input (that is, you are trying to drive the PXI backplane), but there is already 
another device that has ownership of the backplane. 

In cases where you are trying to connect a bi-directional connection point to another bi-
directional routing point, you are asked to specify which you want to configure as an output 
and which as an input. 
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Chapter 5   
Combiner front panel 

Overview 
The Combiner Front Panel plugin allows you to set up and control a combiner instrument 
(3060 Series). 

To open the combiner front panel, click Instrument Control on the top-level PXI Studio 
menu, and select Combiner Front Panel. 

If this entry does not appear on the top level menu, select Tools -> Registered Plugins and add 
the plugin afCombinerPlugin.dll. 

When opening the combiner front panel, if there is only one combiner instrument available in 
your system, it is automatically selected and booted.  Otherwise, you are asked to select which 
instrument you wish to control: 
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This screen provides a list of ‘logical instruments’ that you have defined in your System 
Configuration, which match the type you have requested.  Note that instruments that are 
currently in use by other plugins do not appear in this list. 

Click on the name of the instrument you wish to use, and click Ok.  Alternatively, if you do 
not wish to proceed to the Signal Generator front panel, or the hardware you wish to control is 
not present in the list, click Cancel. 

Once you click Ok, the instrument and other instruments that comprise your frequency 
standard (depending on the frequency standard configuration defined in System 
Configuration) are booted if required.  If this instrument has already been booted since 
PXI Studio was started, then the device is only reset. 
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Once the instrument has been booted, you should see the following main screen: 

 

This screen provides all the settings required to control the Combiner, and consists of the 
following controls: 

Mode: 
• This control specifies the current mode of the combiner.  The modes available will depend 

upon the model of the combiner being used. 
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Switch graphic: 
The switch graphic provides a graphical representation of the combiner’s internal connections 
for a given combiner mode.  Whenever you change the combiner mode, this graphic is 
updated with the new settings. 

Frequency: 
The frequency control allows you to retrieve the calibration factors of combiner’s connections 
for a given frequency.  Changing this control automatically updates the calibration factors 
control. 

Calibration Factors: 
The Calibration Factors table displays the calibration factor associated with all the 
connections associated with the current combiner mode. 

Instrument Details 
This button allows you to view the hardware details of the instrument that is currently in use 
by this plugin. 
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Chapter 6   
Spectrum Analysis plugin 

Overview 
The Spectrum Analysis Plugin allows you to perform spectral measurements using a digitizer 
instrument (303x and 301x PXI Modules). 

This plugin provides a graphical front end for the Spectrum Measurement Library 
(afMeasureSpectrumDll.dll), which must be installed if you intend to use this plugin. 

To open a spectrum analysis measurement, click ‘Measurements’ on the top-level PXI Studio 
menu and select Spectrum Analysis. 

If this entry does not appear on the top level menu, select Tools -> Registered Plugins and add 
the plugin afSpectrumPlugin.dll. 

Note: this plugin is supplied with PXI Studio, but has its own separate installer.  This chapter 
assumes that the PXI Studio and Spectrum installers have been run from the same 
distribution.  If a different version of the Spectrum plugin is installed, the functionality may 
differ. 
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When opening a Spectrum Analysis measurement, if there is only one Digitizer instrument 
available in your system, it is automatically selected and booted.  Otherwise, you are asked to 
select which instrument you wish to control: 

 
This screen provides a list of Logical Instruments (that you have defined in your System 
Configuration) that match the type you have requested.  Note that instruments that are 
currently in use by other plugins do not appear in this list. 

Click on the name of the instrument you wish to use, and click Ok.  Alternatively, if you do 
not wish to proceed to the Spectrum Analysis measurement, or the hardware you wish to 
control is not present in the list, click Cancel. 
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Once you click Ok, the instrument and (depending on your frequency standard configuration 
defined in System Configuration) other instruments that comprise your frequency standard are 
booted if required.  If this instrument has already been booted since PXI Studio was started, 
then the device is only reset. 

Once the instrument has been booted, you should be presented with the following main 
screen: 

 
This screen contains panels for Spectrum, RF, Zero Span, Occupied Bandwidth (OBW) and 
ACP settings, as well as panels for Measurement settings, Text and graphical results. 

For information about how to manipulate these panels in order to create a customized layout, 
see Common Plugin Control. 
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Parameter entry 
To edit a numeric value, you can use the up and down keys or arrow button to increase or 
decrease the value.  Alternatively, you can type the value you require with appropriate units.  
When editing the value, the background color of the control turns yellow to indicate that it has 
changed.  To apply any manual changes, press return.  To cancel your changes, press the 
escape key. 

Changing the Step 
Numeric entry boxes allow you to step the value entered up or down by a given value.  To edit 
the value the numeric entry is stepped by, right-click on the edit box, and click Edit Step. 

 
To edit the step, simply select the step value and units (if applicable) and click Ok.  To reject 
your changes, select Cancel.  Note that this only modifies the step of the numeric entry you 
have clicked on, and no others.  If the window containing the numeric entry is closed, the user 
step value you have entered is not remembered when you come to reopen it. 

Conflicts 
As not all parameters values can be valid, (either limited by hardware constraints such as the 
center frequency, or limited by the values of one or more other parameters, such as center 
frequency and span) all parameter entry fields highlight any conflict by showing the conflicted 
parameter in red.  A warning message is displayed, indicating the nature of the error.  If a 
measurement is in progress, it is stopped. 
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To view the conflict that has occurred, move the mouse cursor over the parameter entry box 
for a moment to show the context-sensitive tool tip for that item.  This shows any errors that 
occurred when trying to set the value you have entered. 
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The Spectrum settings panel 

 
Averages / Repeat Count 
This control allows you to specify the number of averages that are performed on the spectral 
measurements being made.  Averages are unavailable when max hold is enabled. 

However, when using N * repeat in max hold mode, this control specifies the number of 
measurements that are made. 
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Window Type 
This control allows you to specify the window type used when performing a spectral 
measurement.  The options are Gaussian 3dB, Gaussian Noise and Blackman-Harris. 

Resolution BW (resolution bandwidth) 
This control allows you to specify the resolution bandwidth of the measurement. 

Max Hold 
This control allows you to turn max hold on and off.  When this control is checked, the 
spectral measurements being made accumulate the maximum value over subsequent 
measurements. 

N Peaks 
The Spectrum Analysis plugin provides the ability to continuously measure a given number of 
the highest peaks within a spectral measurement.  This control allows you to specify how 
many peaks are measured.  The peak values are displayed in the Text Display Panel. 
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The RF Settings panel 

 
This panel sets the basic RF parameters of the spectral measurement you want to make.  It 
consists of the following controls: 

Frequency Center 
This control allows you to set the center frequency of the spectral measurement. 

Frequency Span 
This control allows you to set the span of a spectral measurement. 
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Attenuation Mode 
This control allows you to specify how the RF Attenuation of the digitizer hardware is 
applied.  This can either be Auto or manual. 

In auto mode, the RF attenuation is automatically calculated from the reference level. 

In Manual mode, you are able to directly specify the amount of RF attenuation that the 
digitizer hardware uses. 

RF Input Level 
This control allows you to specify the RF Input level for the measurements you are making. 

RF Attenuation 
This control allows you to specify the amount of RF Attenuation that is used for the specified 
measurement.  When in automatic mode, this control automatically reflects the current amount 
of RF attenuation that has been configured on your digitizer instrument. 
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Instrument Details 
This button allows you to view the hardware details of the instrument that is currently in use 
by this plugin. 
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The Occupied Bandwidth (OBW) settings panel 

 
This panel sets the parameters for an Occupied Bandwidth (OBW) measurement.  The 
occupied bandwidth measurement measures the frequency within which some percentage of a 
signal lies.  The panel consists of the following controls: 

OBW Width 
This control sets the width over which the occupied bandwidth is measured. 

OBW Percentage 
This control sets the percentage of signal power that is used to calculate the occupied 
bandwidth 
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The Adjacent Channel Power (ACP) settings panel 

 
This panel sets the parameters for an Adjacent Channel Power (ACP) measurement. 

ACP Mode 
This control allows you to specify how the ACP information is set up when making ACP 
measurements.  The possible values are User and Auto. 

In Auto ACP mode, there is a fixed number of ACP channels that are measured, as well as a 
common measurement width and spacing for each of those channels. 

In User ACP mode, you can define any number of ACP channels as well as independently 
setting each channel’s spacing and width. 
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ACP Channel definition 

 

Offset Frequency 
This control allows you to specify the position of the carrier channel relative to the RF Centre 
frequency specified.  If you want the carrier channel to be centered around the RF center 
frequency, this parameter should be zero. 

Channel Width 
This control allows you to specify the width of all automatic ACP channels.  This control is 
only enabled in Automatic ACP mode. 
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Channel Spacing 
This control allows you to specify the channel spacing of all automatic ACP channels.  This 
control is only enabled in Automatic ACP mode. 

Filter Alpha 
This control allows you to specify the Filter Alpha of the ACP measurement. 

Configure Channels 
Clicking this button allows you to define customized channel settings when in User ACP 
mode.  For more information, see User ACP Channel settings. 
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User ACP channel settings 

 
This window allows you to modify the user-defined channels used when making an ACP 
measurement. 

Number of Adjacent Channels 
This defines how many channels there are on either side of the carrier.  For instance, if you set 
the number of adjacent channels to two, two upper and two lower channels are defined. 
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Editing an item 
To edit an item, either select the item and press the space key, or double-click on the item to 
bring up an edit box: 

 
Then simply press the enter key to apply the changes. 
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The Measurement settings panel 

 
This panel allows you to set up and control measurements that are being made.  It consists of 
the following controls: 

Maximum Update Rate: 
This control allows you to limit the screen update rate.  As the spectrum measurement library 
is optimized for speed, on some faster machines screen updates may occur too quickly to 
make some text and graphical measurement easily readable.  This control limits the graphical 
update rate of the Spectrum Measurement Plugin, to make it easier to see updates that occur.  
It is important to note that this update rate is limiting only the display of measurements, rather 
than limiting the number of measurements themselves. 
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Prefer speed over resolution 
This control allows you to specify whether to increase the speed of the measurement at the 
detriment of measurement resolution at low sample rates. 

Start/Stop Measurement 
This button toggles the current state of your measurements.  If you are not performing a 
measurement, this control is colored red and labeled ‘Start Measurement’; if you are 
capturing, this control is colored green and labeled ‘Stop Measurement’.  To toggle the state, 
simply click on this button, and your measurements start and stop accordingly. 

Repeat / N * Repeat / Single 
This button toggles the current repeat state of your measurement.  This can either be single N 
* repeated, or repeated. 

Single repeat mode indicates that only one set of measurements is performed.  If in N * repeat 
mode, the measurement is repeated the number of times specified by the number of averages / 
repeat count in the Spectrum Settings Panel.  If in repeat mode, the measurements are 
performed continuously until you decide to stop. 

Reset Averages 
This button resets the accumulated average where applicable.  This button is only enabled if 
you are in continuous run mode and have a number of averages greater than one. 

Triggering 
This button displays a popup window that allows you to edit or modify how the measurements 
are triggered. 
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Trigger Settings 

 
This screen allows you to specify how your measurements are triggered: 

Trigger Type 
This specifies what triggers your measurement: 

Immediate 
Selecting this trigger type means that the measurement is triggered automatically when you 
click on Start Measurement. 

Video 
Selecting this trigger type means that the measurement is triggered whenever the RF level 
rises above a given level. 

External 
Selecting this trigger means that the trigger is supplied by an external device. 



SPECTRUM ANALYSIS PLUGIN 

175 

Trigger Source 
This selects which hardware line to trigger from when using an external trigger type. 

Trigger Level 
This selects the level at which to trigger when in video trigger mode. 

Trigger Delay 
It is possible that you may want to perform measurements on acquired data that occurs some 
time before or after the digitizer has been triggered.  This property allows you to specify the 
amount of time between receiving the trigger and the start of data acquisition.  This can be a 
positive number, indicating that data is acquired some time after a trigger, or a negative 
number, indicating that the data is acquired for a portion of time before the trigger is received. 

Trigger Polarity 
This selects the polarity of the trigger when in video trigger mode. 
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The Zero Span settings panel 

 
This panel sets the parameters for all Zero Span measurements.  It consists of the following 
controls: 

Auto 
This control allows you select whether to perform a spectral measurement and a zero span 
measurement on the same data from the digitizer.  If this control is checked, the zero span and 
spectral measurements use the same sampling rate, and the number of points is automatically 
generated.  Note that if you have a spectral measurement that has a high sampling rate, the 
auto button causes a large zero span measurement to be made, which may decrease the update 
rate and performance of PXI Studio. 
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Points 
This control allows you to specify the number of points that are captured and displayed on the 
screen when the measurement is made.  Note that specifying a high number of sample points 
to be captured and displayed may use a large amount of memory and can lower the update rate 
of the application. 

Time 
This control allows you to specify the total amount of time that the zero span measurement 
encompasses. 

Sampling Frequency 
This control displays the sampling rate of the zero span measurement that is being made. 
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Making a measurement 
When you click the Start Measurement button to start the analysis of your signal, the 
measurements you have currently selected to display in either a text, or graphical 
representation are made.  The measurements you are not currently displaying are not made in 
order to keep optimal update speeds. 

If you are in continuous run mode, and you change the measurement you want to display by, 
for instance, selecting a new item in the Text display panel, or changing graph types in the 
Graph Control panel, any measurements in progress are aborted, and a new measurement is 
started. 

If you are in single run mode, and you change the measurement you want to display, you have 
to restart the analysis by clicking Start Measurement again. 

It is also important to note that changing any settings parameter in this plugin also aborts any 
measurements that are currently in progress and automatically restarts them. 
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Measurement toolbar 

 
The Measurement toolbar allows you to view the overall status of the measurement or 
measurements that are currently in progress.  It consists of the following sections: 

Errors 
This section displays any errors that occurred when making a measurement.  If an error has 
occurred, this section changes color to red, and displays the most recent error: 

 
If a warning has occurred, this section changes color to yellow, and displays the most recent 
warning.  To view details of all the errors that have occurred while processing the 
measurement, double-click on the error section, and an error summary window is displayed. 

ADC Status 
This section displays whether the ADC of the digitizer in use was flagged as being overloaded 
at any stage of the measurement.  If the ADC was overloaded, this section changes color to 
red. 

Measurement Status 
This section of the tool bar displays the current status of the measurement library. 
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The Output Display panel 
This panel displays the results of measurements in a graphical format.  It uses the standard 
Graph Output Display panel described in Common Plugin Control. 

The available graph types are as follows: 

Spectrum 

 
This graph type allows you to display the spectrum of the signal you are measuring, as well as 
the Occupied Bandwidth (OBW) and Adjacent Channel Power (ACP). 
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By default, ACP and Occupied Bandwidth are disabled.  However, you can enable them 
through the Graph Control Menu, which can be accessed by right-clicking on the graticule.  
To enable or disable ACP, Occupied Bandwidth or Power vs Frequency traces, select the 
‘Trace Controls’ menu item, and select the graph type from the item list: 

 

Holding the trace 
You can freeze the current set of measurement data in the spectrum trace by accessing the 
Trace Controls menu item in the Graph Control menu, and checking the ‘Hold Trace’ item.  
This freezes the trace until you decide to uncheck this item. 



SPECTRUM ANALYSIS PLUGIN 

182 

Spectrum marker functions 
As well as the standard marker functions described in Common Plugin Control, the spectrum 
trace also provides extra functionality for markers. 

These functions can be found within the Marker section of the Graph Control menu, which is 
accessible by right-clicking on the Graph Display. 

Find Peak 
Selecting this menu item moves the marker to the peak of the current spectrum trace. 

Next Peak 
Selecting this menu item moves the marker to the next peak of the current spectrum trace. 

Note: Next Peak is enabled only if there is no measurement running, or the trace has been 
held and if a Find Peak has already been selected. 

Track Peak 
Checking this menu item causes the marker to move automatically to the peak of the spectrum 
whenever an update occurs. 
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Power vs Time 

 
This plot type allows you to display a power vs time trace of the signal you are measuring. 

Holding the trace 
You can freeze the current set of measurement data in the spectrum trace by accessing the 
Trace Controls menu item in the Graph Control menu, and checking the ‘Hold Trace’ item.  
This freezes the trace until you decide to uncheck this item. 
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Frequency vs Time 

 
This plot type allows you to display a frequency vs time trace of the signal you are measuring. 

Holding the trace 
You can freeze the current set of measurement data in the frequency vs time trace by 
accessing the Trace Controls menu item in the Graph Control menu, and checking the ‘Hold 
Trace’ item.  This freezes the trace until you decide to uncheck this item. 
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Phase vs Time 

 
This plot type allows you to display a phase vs time trace of the signal you are measuring. 

Holding the trace 
You can freeze the current set of measurement data in the phase vs time trace by accessing the 
Trace Controls menu item in the Graph Control menu, and checking the ‘Hold Trace’ item.  
This freezes the trace until you decide to uncheck this item. 
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The Text Results Display panel 
This panel displays the results of measurements in a text format. 

 
The measurements that can be displayed here are Adjacent Channel Power, Occupied 
Bandwidth, Average Power and Peak Values.  To enable each measurement, simply select the 
item on the Measurements menu and the measurement appears in the main panel.  To disable a 
measurement, select it again in the menu. 
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AEROFLEX LIMITED 
SOFTWARE LICENSE AND WARRANTY 
This document is an Agreement between the user of this Licensed Software, the Licensee, and Aeroflex Limited (‘Aeroflex’), the 
Licensor.  By installing or commencing to use the Licensed Software you accept the terms of this Agreement.  If you do not agree to 
the terms of this Agreement do not use the Licensed Software. 

1. DEFINITIONS 
The following expressions will have the meanings set out below for the purposes of this Agreement: 

Add-In Application Software Licensed Software that may be loaded separately from time to time into the Designated 
Equipment to improve or modify its functionality 

Computer Application Software Licensed Software supplied to run on a standard PC or workstation 
Designated Equipment means either: 

the single piece of equipment or system supplied by Aeroflex upon which the Licensed 
Software is installed; or 
a computer that is connected to a single piece of equipment or system supplied by Aeroflex 
upon which computer the Licensed Software is installed 

Downloaded Software any software downloaded from an Aeroflex web site 
Embedded Software Licensed Software that forms part of the Designated Equipment supplied by Aeroflex and 

without which the Equipment cannot function 
License Fee means either the fee paid or other consideration given to Aeroflex for the use of the 

Licensed Software on the Designated Equipment 
Licensed Software all and any programs, listings, flow charts and instructions in whole or in part including 

Add-in, Computer Application, Downloaded and Embedded Software supplied to work with 
Designated Equipment 

PXI Software Licensed Software specific to Aeroflex’s 3000 Series PXI product range 

2. LICENSE FEE 
The Licensee shall pay the License Fee to Aeroflex in accordance with the terms of the contract between the Licensee and 
Aeroflex. 

3. TERM 
This Agreement shall be effective from the date of receipt or download (where applicable) of the Licensed Software by the Licensee 
and shall continue in force until terminated under the provisions of Clause 8. 

4. LICENCE 
4.1 The following rights and restrictions in this Article 4 apply to all Licensed Software unless otherwise expressly stated in other 

Articles of this Agreement. 
4.2 Unless and until terminated, this License confers upon the Licensee the non-transferable and non-exclusive right to use the 

Licensed Software on the Designated Equipment. 
4.3 The Licensee may not use the Licensed Software on other than the Designated Equipment, unless written permission is first 

obtained from Aeroflex and until the appropriate additional License Fee has been paid to Aeroflex. 
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4.4 The Licensee may not amend or alter the Licensed Software and shall have no right or license other than that stipulated 
herein. 

4.5 Except as specifically permitted elsewhere in this Agreement the Licensee may make not more than two copies of the 
Licensed Software (but not the Authoring and Language Manuals) in machine-readable form for operational security and shall 
ensure that all such copies include Aeroflex's copyright notice, together with any features which disclose the name of the 
Licensed Software and the Licensee.  Furthermore, the Licensee shall not permit the Licensed Software or any part to be 
disclosed in any form to any third party and shall maintain the Licensed Software in secure premises to prevent any 
unauthorized disclosure.  The Licensee shall notify Aeroflex immediately if the Licensee has knowledge that any unlicensed 
party possesses the Licensed Software.  The Licensee's obligation to maintain confidentiality shall cease when the Licensed 
Software and all copies have been destroyed or returned.  The copyright in the Licensed Software shall remain with Aeroflex.  
The Licensee will permit Aeroflex at all reasonable times to audit the use of the Licensed Software. 

4.6 The Licensee will not disassemble or reverse engineer the Licensed Software, nor sub-license, lease, rent or part with 
possession or otherwise transfer the whole or any part of the Licensed Software. 

 

5 ADDITIONAL LICENSE RIGHTS SPECIFIC TO PXI SOFTWARE 
5.1 Definitions for PXI Software 

The following expressions will have the meanings set out below for the purposes of the supplementary rights granted in this 
Article. 
PXI Drivers All 3000 Series PXI module device drivers including embedded firmware that are 

installed at runtime  
PXI Executable Applications All executable applications supplied with each 3000 Series PXI module including:- 

PXI Studio 
Soft Front Panels (manual operation graphical user interfaces) 
Utilities including: RF Investigator, PXI Version Information and Self Test 

PXI Spectrum Analysis Library The spectrum analysis measurement suite library .dll software supplied with each 3000 
Series PXI module 

PXI Optional Application Library Individual measurement suite available from a range of optional .dll application 
libraries 

 
5.2 PXI Drivers, PXI Executable Applications and PXI Spectrum Analysis Library License Rights 

Subject to the License granted in Article 4 hereof notwithstanding the limitations on number of copies in Clause 4.5 hereof, the 
Licensee is entitled to make and distribute as many copies of the PXI Drivers and PXI Executable Applications as necessary 
for use with 3000 Series PXI modules acquired by the Licensee from Aeroflex or its authorized distributor or reseller provided 
that the Licensee may not sell or charge a fee for the PXI Drivers and PXI Executable Applications.   

5.3 PXI Optional Application Library License Rights 
Subject to the License granted in Article 4 hereof notwithstanding the limitations on number of copies in Clause 4.5 hereof,  the 
Licensee is entitled to distribute as many copies of any PXI Optional Application Library as necessary for use with 3000 Series 
PXI modules acquired by the Licensee from Aeroflex or its authorized distributor or reseller provided that: 
5.3.1 copies of the applicable PXI Optional Application Library are used solely with 3000 Series PXI modules which the 

customer has purchased with the corresponding option or part number for the applicable PXI Optional Application 
Library; and  

5.3.2 the Licensee may not sell or charge a fee for the PXI Optional Application Library. 
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6 WARRANTY 
6.1 Aeroflex certifies that the Licensed Software supplied by Aeroflex will at the time of delivery function substantially in 

accordance with the applicable Software Product Descriptions, Data Sheets or Product Specifications published by Aeroflex. 
6.2 The warranty period (unless an extended warranty for Embedded Software has been purchased) from date of delivery in 

respect of each type of Licensed Software is: 
PXI Drivers 24 months 
Embedded Software 12 months 
Add-In  Application Software 90 days 
Computer Application Software 90 days 
Downloaded Software No warranty 

 
6.3 If during the appropriate Warranty Period the Licensed Software does not conform substantially to the Software Product 

Descriptions, Data Sheets or Product Specifications Aeroflex will provide: 
6.3.1 In the case of Embedded Software and at Aeroflex’s discretion either a fix for the problem or an effective and efficient 

work-around. 
6.3.2 In the case of Add-In Application Software and Computer Application Software and at Aeroflex’s discretion replacement 

of the software or a fix for the problem or an effective and efficient work-around. 
6.4 Aeroflex does not warrant that the operation of any Licensed Software will be uninterrupted or error free. 
6.5 The above Warranty does not apply to: 

6.5.1 Defects resulting from software not supplied by Aeroflex, from unauthorized modification or misuse or from operation 
outside of the specification. 

6.5.2 Third party produced proprietary software which Aeroflex may deliver with its products, in such case the third party 
software license agreement including its warranty terms shall apply. 

6.6 The remedies offered above are sole and exclusive remedies and to the extent permitted by applicable law are in lieu of any 
implied conditions, guarantees or warranties whatsoever and whether statutory or otherwise as to the Licensed Software all of 
which are hereby expressly excluded. 

7. INDEMNITY 
7.1 Aeroflex shall defend, at its expense, any action brought against the Licensee alleging that the Licensed Software infringes any 

patent, registered design, trademark or copyright, and shall pay all Licensor's costs and damages finally awarded up to an 
aggregate equivalent to the License Fee provided the Licensee shall not have done or permitted to be done anything which 
may have been or become any such infringement and shall have exercised reasonable care in protecting the same failing 
which the Licensee shall indemnify Aeroflex against all claims costs and damages incurred and that Aeroflex is given prompt 
written notice of such claim and given information, reasonable assistance and sole authority to defend or settle such claim on 
behalf of the Licensee.  In the defense or settlement of any such claim, Aeroflex may obtain for the Licensee the right to 
continue using the Licensed Software or replace it or modify it so that it becomes non-infringing.  

7.2 Aeroflex shall not be liable if the alleged infringement: 
7.2.1 is based upon the use of the Licensed Software in combination with other software not furnished by Aeroflex, or 
7.2.2 is based upon the use of the Licensed Software alone or in combination with other software in equipment not 

functionally identical to the Designated Equipment, or 
7.2.3 arises as a result of Aeroflex having followed a properly authorized design or instruction of the Licensee, or 
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7.2.4 arises out of the use of the Licensed Software in a country other than the one disclosed to Aeroflex as the intended 
country of use of the Licensed Software at the commencement of this Agreement. 

7.3 Aeroflex shall not be liable to the Licensee for any loss of use or for loss of profits or of contracts arising directly or indirectly 
out of any such infringement of patent, registered design, trademark or copyright.  Notwithstanding anything in this Agreement 
to the contrary, the total liability of Aeroflex and its employees, in contract, tort, or otherwise (including negligence, warranty, 
indemnity, and strict liability) howsoever arising out of this License shall be limited to the total amount of the License Fee and 
total support fees actually paid to Aeroflex by the Licensee. 

8. TERMINATION 
8.1 Notwithstanding anything herein to the contrary, this License shall forthwith determine if the Licensee: 

8.1.1 As an individual has a Receiving Order made against him or is adjudicated bankrupt or compounds with creditors or as a 
corporate body, compounds with creditors or has a winding-up order made against it  or 

8.1.2 Parts with possession of the Designated Equipment. 
8.2 This License may be terminated by notice in writing to the Licensee if the Licensee shall be in breach of any of its obligations 

hereunder and continue in such breach for a period of 21 days after notice thereof has been served on the Licensee. 
8.3 On termination of this Agreement for any reason, Aeroflex may require the Licensee to return to Aeroflex all copies of the 

Licensed Software in the custody of the Licensee and the Licensee shall, at its own cost and expense, comply with such 
requirement within 14 days and shall, at the same time, certify to Aeroflex in writing that all copies of the Licensed Software in 
whatever form have been obliterated from the Designated Equipment. 

9. THIRD PARTY LICENCES 
9.1 The Licensed Software or part thereof may be the proprietary property of third party licensors. In such an event such third party 

licensors (as may be referenced on the software media, or any on screen message on start up of the software or on the order 
acknowledgement) and/or Aeroflex may directly enforce the terms of this Agreement and may terminate the Agreement if the 
Licensee is in breach of the conditions contained herein. 

9.2 If any third party software supplied with the Licensed Software is supplied with, or contains or displays the third party’s own 
license terms then the Licensee shall abide by such third party license terms (for the purpose of this Article the term “third 
party” shall include other companies within the Aeroflex group of companies).   

10. EXPORT REGULATIONS 
The Licensee undertakes that where necessary the Licensee will conform with all relevant export regulations imposed by the 
Governments of the United Kingdom and/or the United State of America. 

11. U.S. GOVERNMENT RESTRICTED RIGHTS 
The Licensed Software and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software 
clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 
CFR 52.227-19, as applicable. 

12. NOTICES 
Any notice to be given by the Licensee to Aeroflex shall be addressed to: 
Aeroflex Limited, Longacres House, Six Hills Way, Stevenage, SG1 2AN, UK. 

13. LAW AND JURISDICTION 
This Agreement shall be governed by the laws of England and shall be subject to the exclusive jurisdiction of the English courts.  
This agreement constitutes the whole agreement between the parties and may be changed only by a written agreement signed by 
both parties. 

© AEROFLEX LIMITED 2009 
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CHINA Shanghai 
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As we are always seeking to improve our products, the information in this document gives only a general indication of 
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